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ALTERAWY

1. About DSP Builder

Release Information

Table 1-1 provides information about this release of DSP Builder.

Table 1-1. DSP Builder Release Information

Item Description
Version 11.0
Release Date April 2011
Ordering Code IPT-DSPBUILDER

Device Family Support

DSP Builder supports the following Altera® device families:

B Arria™ GX
m  Arria I GX
m Cyclone®

m Cyclone Il
m Cyclone III.
m Stratix®

B Stratix GX
m Stratix II

m Stratix II GX
m Stratix III

m Stratix [V

Memory Options

A number of the blocks in the Storage library allow you to choose the required
memory block type. In general, DSP Builder lists all supported memory block types as
options although some may not be available for all device families.

Table 1-2 on page 1-1 shows the device families that support each memory block

type.

Tahle 1-2. Supported Memory Block Types

Memory Block Type

Device Family

M144K

Stratix IV, Stratix Ill, Arria 1l GX

M9K

Stratix 1V, Stratix IIl, Cyclone IlI, Arria Il GX

MLAB

Stratix IV, Stratix I, Arria [ GX
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Features
Table 1-2. Supported Memory Block Types
Memory Block Type Device Family
M-RAM Stratix Il GX, Stratix Il, Stratix GX, Stratix, Arria GX
M4K Stratix Il GX, Stratix I, Stratix GX, Stratix, Arria GX, Cyclone II, Cyclone
M512 Stratix Il GX, Stratix II, Stratix GX, Stratix, Arria GX

Features

<o For more information about each memory block type, refer to the Quartus II Help.

DSP Builder standard blockset supports the following features:

Links The MathWorks MATLAB (Signal Processing ToolBox and Filter Design
Toolbox) and Simulink software with the Altera® Quartus® II software.

Generates VHDL testbench and controls Quartus II compilation.

Provides a variety of fixed-point arithmetic and logical operators for use with the
Simulink software.

Enables rapid prototyping using Altera DSP development boards.

Supports the SignalTap® IT logic analyzer—an embedded signal analyzer that
probes signals from the Altera device on the DSP board and imports the data into
the MATLAB workspace to ease visual analysis.

Allows HDL import of VHDL or Verilog HDL design entities and HDL defined in
a Quartus II project file.

Supports hardware-in-the loop (HIL) to enable FPGA hardware accelerated
cosimulation with Simulink.

Supports Avalon® Memory-Mapped (Avalon-MM) interfaces including user
confiéurable blocks, which you can use to build custom logic that works with the
Nios™ II processor and other SOPC Builder designs.

Supports Avalon Streaming (Avalon-ST) interfaces including an Packet Format
Converter block and configurable Avalon-ST sink and Avalon-ST source blocks.

Allows you to instance Altera DSP MegaCore® functions in a DSP Builder design
model.

Supports tabular and graphical state machine editing.

e« Forinformation about new features and errata in this release, refer to the DSP Builder

Release Notes and Errata.

General Description

Digital signal processing (DSP) system design in Altera programmable logic devices
(PLDs) requires both high-level algorithm and hardware description language (HDL)
development tools.

DSP Builder Handbook
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General Description

The Altera DSP Builder integrates these tools by combining the algorithm
development, simulation, and verification capabilities of The MathWorks MATLAB
and Simulink system-level design tools with VHDL and Verilog HDL design flows,
including the Altera Quartus II software.

DSP Builder shortens DSP design cycles by helping you create the hardware
representation of a DSP design in an algorithm-friendly development environment.

You can combine existing MATLAB functions and Simulink blocks with Altera
DSP Builder blocks and Altera intellectual property (IP) MegaCore functions to link
system-level design and implementation with DSP algorithm development. In this
way, DSP Builder allows system, algorithm, and hardware designers to share a
common development platform.

The DSP Builder Signal Compiler block reads Simulink Model Files (.mdl) that
contain other DSP Builder blocks and MegaCore functions. Signal Compiler then
generates the VHDL files and Tcl scripts for synthesis, hardware implementation, and
simulation.

High-Speed DSP with Programmable Logic

Programmable logic offers compelling performance advantages over dedicated DSP
processors. Think of programmable logic as an array of elements, each of which you
can configure as a complex processor routine.

You can link these routines together in serial (the same way that a DSP processor
executes them), or connect them in parallel. When connected in parallel, they give
many times better performance than standard DSP processors by executing hundreds
of instructions at the same time.

Algorithms that benefit from this improved performance include forward-error
correction (FEC), modulation and demodulation, and encryption.

Interoperability with the Advanced Blockset

DSP Builder includes an optional advanced blockset.
“% e For more information about the advanced blockset, refer to Volume 3: DSP Builder
Advanced Blockset in the DSP Builder Handbook.
“% e For more information about the differences between the standard and advanced
blocksets and about design flows that combine both blocksets, refer to Volume 1:
Introduction to DSP Builder in the DSP Builder Handbook.

June 2012  Altera Corporation DSP Builder Handbook
Volume 2: DSP Builder Standard Blockset


http://www.altera.com/literature/hb/dspb/hb_dspb_adv.pdf
http://www.altera.com/literature/hb/dspb/hb_dspb_adv.pdf
http://www.altera.com/literature/hb/dspb/hb_dspb_intro.pdf
http://www.altera.com/literature/hb/dspb/hb_dspb_intro.pdf

1-4 Chapter 1: About DSP Builder
General Description

DSP Builder Handbook June 2012  Altera Corporation
Volume 2: DSP Builder Standard Blockset



2. Getting Started
/ANO[S YA !

This chapter describes the design flow and a tutorial.

Design Flow

When using DSP Builder, you start by creating a Simulink design model in the
MathWorks software. After you have created your model, you can compile directly in
the Quartus II software, output VHDL files for synthesis and Quartus II compilation,
or generate files for VHDL simulation.

DSP Builder generates VHDL and does not generate Verilog HDL. However, after you
have created a Quartus II project, you can use the quartus_map command in the
Quartus II software to run a simulation netlist flow that generates files for Verilog
HDL simulation.

“ e TFor information about this flow, refer to the Quartus I help.
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Design Flow

Figure 2-1 shows the system-level design flow using DSP Builder.

Figure 2-1. System-Level Design Flow

- MATLAB
Sirnulink
\
Automated Flow SignalCompiler Manual Flow
(Within Simulink) | [Cutside Simulink)
| l Y L
ModelSim Synthesis
Co-Simulati A +
o 'I.-J:'?LL;!B lon Quartus 11 Synthesis A
Hardware ATOM
in the Loop Netlist
ATOM Netlist + Y
Cearius |1 Finer Cuarius Il Fitter VHDL

r | Simulator

)

Programmar

| Object File :.poﬁ!
* Hardwara

The design flow involves the following steps:

1. Use the MathWorks software to create a model with a combination of Simulink
and DSP Builder blocks.

L= Separate The DSP Builder blocks in your design from the Simulink blocks
by Input and Output blocks from the DSP Builder IO and Bus library.

2. Include a Clock block from the DSP Builder AltLab library to specify the base clock
for your design, which must have a period greater than 1ps but less than 2.1 ms.

I'=" 1If no base clock exists in your design, DSP Builder creates a default clock
with a 20ns real-world period and a Simulink sample time of 1. You can
derive additional clocks from the base clock by adding Clock Derived
blocks.

DSP Builder Handbook June 2012  Altera Corporation
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3. Seta discrete (no continuous states) solver in Simulink. Choose a Fixed-step solver
type if you are using a single clock domain or a Variable-step type if you use

multiple clock domains.

To set the solver options, click Configuration Parameters on the Simulation menu
to open the Configuration Parameters dialog box and select the Solver page

(Figure 2-2).

Figure 2-2. Configuration Parameters for Simulation

% Configuration Parameters: fir3tap/Configuration (Active)

. Select: Sirnulation time
| -Balver
: Start kime: | 0.0 Stop kime:
- Data Import/Export Al GEeeg] 10.0
-~ Optirnization -
B} Diagnostics Sokver options
E----Sample Tifme Tvpe: Fixed-step | % Solver: Discrete {no continuous states)
Data Yalidity
Type Comversion Fixed-step size (fundamental sample time): | auto
Zonnectivity
Compatibiity Tasking and sample time options
i~ Model Referencing
‘e Saving Periodic sample time conskraint: Unconstrained
-Hardware Implementation ; e . ; ;
- Model Referencing Tasking mode For periodic sample times; SingleTasking
& Sil:nulation Targst [] awkomatically handle rate transition for data transfer
& Symbols
L Custom Code [] Higher priority value indicates higher task priarity
[+-Real-Time Workshop
\_) [ ok l I Cancel I [ Help I

Apply

“Solver Pane” in the Simulink Help.

For detailed information about solver options, refer to the description of the

4. Simulate your model in Simulink using a Scope block to monitor the results.

5. Run Signal Compiler to setup RTL simulation and synthesis.

6. Perform RTL simulation. DSP Builder supports an automated flow for the
ModelSim software (using the TestBench block). You can also use the generated
VHDL for manual simulation in other simulation tools.

7. Use the output files generated by the DSP Builder Signal Compiler block to
perform RTL synthesis. Alternatively, you can synthesize the VHDL files manually
using other synthesis tools.

8. Compile your design in the Quartus II software.

9. Download to a hardware development board and test.

For an automated design flow, the Signal Compiler block generates VHDL and Tcl
scripts for synthesis in the Quartus II software. The Tcl scripts let you perform
synthesis and compilation automatically in the MATLAB and Simulink environment.
You can synthesize and simulate the output files in other software tools without the
Tcl scripts. In addition, the Testbench block generates a testbench and supporting files

for VHDL simulation.
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For information about controlling the DSP Builder design flow using Signal
Compiler, refer to “Design Flows for Synthesis, Compilation and Simulation” on
page 3-19.

For more information about the blocks in the DSP Builder blockset, refer to the DSP
Builder Standard Blockset Libraries section in volume 2 of the DSP Builder Handbook.

Creating the Amplitude Modulation Model

This tutorial uses an amplitude modulation design example, singen.mdl, to
demonstrate the DSP Builder design flow.

The amplitude modulation design example is a modulator that has a sine wave
generator, a quadrature multiplier, and a delay element. Each block in the model is
parameterizable. When you double-click a block in the model, a dialog box displays
where you can enter the parameters for the block. Click the Help button in these
dialog boxes to view help for a specific block.

This tutorial assumes the following points:
®m  You are using a PC running Windows XP.

B You are familiar with the MATLAB, Simulink, Quartus II, and ModelSim®
software and the software is installed on your PC in the default locations.

B You have basic knowledge of the Simulink software.

“ e For information about using the Simulink software, refer to the Simulink
Help.

You can use the singen.mdl model file in <DSP Builder install
path>\DesignExamples\Tutorials\ GettingStartedSinMd]l or you can create your
own amplitude modulation model.

To create the amplitude modulation model, follow these instructions.

Create a New Model

DSP Builder Handbook

To create a new model, follow these steps:

1. Start the MATLAB software.

2. On the File menu, point to New, and click Model to create a new model window.
3. In the new model window, on the File menu click Save.
4

. Browse to a directory, your working directory, to save the file. This tutorial uses
the working directory <DSP Builder install
path>\DesignExamples\Tutorials\ GettingStartedSinMdl\my_SinMdl.

5. Type the file name into the File name box. This tutorial uses the name singen.mdl.
6. Click Save.
7. Click the MATLAB Start button. Point to Simulink and click Library Browser.

June 2012  Altera Corporation
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Add the Sine Wave Block

To add the Sine Wave block, follow these steps:

1. Inthe Simulink Library Browser, click Simulink and Sources to view the blocks in

the Sources library.

2. Dragand drop a Sine Wave block into your model.

3. Double-click the Sine Wave block in your model to display the Block Parameters

dialog box (Figure 2-3).

Figure 2-3. 500-kHz, 16-Bit Sine Wave Specified in the Sine Wave Dialog Box

EI Source Block Parameters: Sine Wave

Sine "Wave

Output & sine wave:
0[] = Amp*SinfFreqt+Phaze] + Bias

Sine twpe determines the computational technigue uzed. The parameters in the two
types are related through:

Samples per period = 2400 / [Frequency * Sample time]
MHurnber of offset samples = Phaze * Samples per period / [2%pi]

Use the zample-based sine type if numerical problems due to winning for large times
[e.a. overflow in abzolute time)] accur.

Parameters

Sine type: Sample bazed |
Time [t U se simulation time |
Amplitude:

127151

Bias:

i

Samples per period:

a0

Mumber of offset samples:

a

55 am|_:|e tirne:

|25e-9

Interpret vector parameters as 1-0

I QK. H Cancel H Help

4. Set the Sine Wave block parameters (Table 2-1).

Table 2-1. Parameters for the Sine Wave Block

Parameter Value

Sine type Sample based
Time simulation time
Amplitude 2M5-1

Bias 0

Samples per period 80

Number of offset examples 0

Sample time 25e-9

Interpret vector parameters a 1-D On

June 2012  Altera Corporation
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5. Click OK.

"=~ For information about how you can calculate the frequency., refer to the
equation in “Frequency Design Rules” on page 3-8.

Add the Sinin Block

To add the SinIn block, follow these steps:

1. In the Simulink Library Browser, expand the Altera DSP Builder Blockset folder
to display the DSP Builder libraries (Figure 2—4).

Figure 2-4. Altera DSP Builder Folder in the Simulink Library Browser

" E Simulink Library Browser E]@ ?(.

||| Fie Edt View Help l

H| O w !é.Eﬁterwarch.term |v}ﬁ

Libraries | Library: Altera DSP Builder Blockset10 & Bus ; >J
B simulink
| G Altera DSP Builder Advanced Blocksst

=1- 9] Attera DSP Buider Blockset > HEE S B

- All Blocks

- AltLab :1[53[33 no]ﬁ;L Binary Point Casting
- Arithmetic

[+]-Boards
- Complex Type
- (Gate & Control
[+]-Interfaces

-0 & Bus h:_'_ilL Bus Concatenation
- MegaCore Functions e
- Rate Change
- Simulation Blocks Library (7)) (63t B Convetsion
- State Maching Functions
- Storage

E

=

H
[’—I' Bus Builder
il

H 2 = Bus Splitter
- Wideo and Image Processing

£ TJ Communications Blockset
E Control System Toolbox Y,

- gl EDA Simulator Link MQ ) Constant
E Image Acquisition Toolbox = -
[+ §g| Real-Time Workshop o e Eibsaii

[+ I Real-Time Workshop Embedded Coder -
E Report Generator
i+ Wl RF Blocksat [36r > | Global Reset
[ TJ Signal Processing Blockset
- g Simulink Control Design

[+ W] Simulink Extras [o> S
E Simulink Verification and Validation
- g Stateflow N
L'!--J Video and Image Processing Blockset 2

(- | Virtual Reality Toolbox )

Block Description x
Input: Input Port b]

In gimulation, thiz block castz a Simulink =ignal to a DSP Builder internal gignal.
Choose from signed integer, unsigned integer or signed fractional representation. The Simulink value |!|

2. Select the IO & Bus library.
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3. Drag and drop the Input block from the Simulink Library Browser into your
model. Position the block to the right of the Sine Wave block.

If you are unsure how to position the blocks or draw connection lines, refer to the
completed design (Figure 2-7 on page 2-14).

=" You can use the Up, Down, Right, and Left arrow keys to adjust the position

of a block.

4. Click the text under the block icon in your model. Delete the text Input and type
the text SinIn to change the name of the block instance.

5. Double-click the SinIn block in your model to display the Block Parameters

dialog box.

6. Set the SinIn block parameters (Table 2-2).

Table 2-2. Parameters for the Sinin Block

Parameter Value
Bus Type Signed Integer
[number of bits].[] 16
Specify Clock Off
7. Click OK.

8. Draw a connection line from the right side of the Sine Wave block to the left side of

the sinIn block by holding down the left mouse button and dragging the cursor

between the blocks.

=~ Alternatively, you can select a block, hold down the Ctrl key and click the
destination block to automatically make a connection between the two

blocks.
Add the Delay Block

To add the Delay block, follow these steps:

1. Select the Storage library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop the Delay block into your model and position it to the right of the
SinIn block.

3. Double-click the Delay block in your model to display the Block Parameters

June 2012  Altera Corporation

dialog box (Figure 2-5).
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4. Type 1 as the Number of Pipeline Stages for the Delay block.

Figure 2-5. Setting the Downsampling Delay

EJ Function Block Parameters: Delay
Drelay AlteraBlockzet [maszk) [link]

Dielay

Implements a parametenized delay.

The 'Mumber of Pipeline Levels' :pecifies the delay length of the black. The delay
must be greater than or equal to 1.

The 'Clock Phaze Selection’ i a binary stiing which gets the phases in which the

block iz enabled.

Far example;
0100 - The delay block iz enabled only on the 2nd phase of 4.

Use the 'Optional Ports’ tab to select uze of the additional clock enable and reset
cantrol inputs.

Usze the Initialization’ tab to select uze of an optional non-zero rezet value [uze of
which will increase the hardware resources used).

M n Optiohal Ports | Initialization

Murnber of Pipeline Stages
1

I 0K l [ Cancel ] ’ Help ] Apply

5. Click the Optional Ports tab and set the parameters (Table 2-3).

Table 2-3. Parameters for the Delay Block.

Parameter Value
Clock Phase Selection 01
Use Enable Port Off
Use Synchronous Clear port Off
6. Click OK.
7. Draw a connection line from the right side of the SinIn block to the left side of the
Delay block.

Add the SinDelay and SinIn2 Blocks

To add the sinDelay and SinIn2 blocks, follow these steps:

1. Select the IO & Bus library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop two Output blocks into your model, positioning them to the right of
the Delay block.

3. Click the text under the block symbols in your model. Change the block instance
names from Output and Outputl to SinDelay and SinIn2.

4. Double-click the sinDelay block in your model to display the Block Parameters
dialog box.

DSP Builder Handbook June 2012  Altera Corporation
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5. Set the sinDelay block parameters (Table 2—4).

Table 2-4. Parameters for the SinDelay Block

Parameter

Value

Bus Type

Signed Integer

[number of bits].[]

16

External Type

Inferred

6. Click OK.

7. Repeat steps 4 to 6 for the SinIn2 block setting the parameters (Table 2-5).

Table 2-5. Parameters for the Sinln2 Block

Parameter

Value

Bus Type

Signed Integer

[number of bits].[]

16

External Type

Inferred

8. Draw a connection line from the right side of the Delay block to the left side of the

SinDelay block.

Add the Mux Block

To add the Mux block, follow these steps:

1.
2.

4.

Select the Simulink Signal Routing library in the Simulink Library Browser.

Drag and drop a Mux block into your design, positioning it to the right of the
SinDelay block.

Double-click the Mux block in your model to display the Block Parameters dialog
box.

Set the Mux block parameters (Table 2-6).

Table 2-6. Parameters for the Mux Block

Parameter Value
Number of Inputs 2
Display Options bar
5. Click OK.
6. Draw a connection line from the bottom left of the Mux block to the right side of the
SinDelay block.
7. Draw a connection line from the top left of the Mux block to the line between the
SinIn2 block.
8. Draw a connection line from the SinIn2 block to the line between the SinIn and

June 2012  Altera Corporation
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Add the Random Bitstream Block

To add the Random Bitstream block, follow these steps:
1. Select the Simulink Sources library in the Simulink Library Browser.

2. Drag and drop a Random Number block into your model, positioning it underneath
the Sine Wave block.

3. Double-click the Random Number block in your model to display the Block
Parameters dialog box.

4. Set the Random Number block parameters (Table 2-7).

Table 2-7. Parameters for the Random number Block

Parameter Value
Mean 0
Variance 1
Initial seed 0
Sample time 25e-9
Interpret vector parameters as 1-D On

5. Click OK.

6. Rename the Random Noise block Random Bitstream.

Add the Noise Block

To add the Noise block, follow these steps:

1. Select the IO & Bus library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop an Input block into your model, positioning it to the right of the
Random Bitstream block.

3. Click the text under the block icon in your model. Rename the block Noise.
4. Double-click the Noise block to display the Block Parameters dialog box.
5. Set the Noise block parameters (Table 2-8).

Table 2-8. Parameters for the Noise Block

Parameter Value
Bus Type Single Bit
Specify Clock Off

& The dialog box options change to display only the relevant options when
you select a new bus type.

6. Click OK.

7. Draw a connection line from the right side of the Random Bitstreamblock to the
left side of the Noise block.
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Add the Bus Builder Block

The Bus Builder block converts a bit to a signed bus. To add the Bus Builder block,
follow these steps:

1. Select the IO & Bus library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop a Bus Builder block into your model, positioning it to the right of
the Noise block.

3. Double-click the Bus Builder block in your model to display the Block
Parameters dialog box.

4. Set the Bus Builder block parameters (Table 2-9).

Table 2-9. Parameters for the Bus Builder Block

Parameter Value
Bus Type Signer Integer
[number of bits].[] 2

5. Click OK.

6. Draw a connection line from the right side of the Noise block to the top left side of
the Bus Builder block.

Add the GND Block

To add the GND block, follow these steps:

1. Select the IO & Bus library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop a GND block into your model, positioning it underneath the Noise
block.

3. Draw a connection line from the right side of the GND block to the bottom left side
of the Bus Builder block.

Add the Product Block

To add the Product block, follow these steps:

1. Select the Arithmetic library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop a Product block into your model, positioning it to the right of the
Bus Builder block and slightly above it. Leave enough space so that you can draw
a connection line under the Product block.

3. Double-click the Product block to display the Block Parameters dialog box.

June 2012  Altera Corporation DSP Builder Handbook
Volume 2: DSP Builder Standard Blockset



2-12 Chapter 2: Getting Started
Creating the Amplitude Modulation Model

4. Set the Product block parameters (Table 2-10).

Table 2-10. Parameters for the Product Block

Parameter Value
Bus Type Inferred
Number of Pipeline Stages 0

=~ The bit width parameters are set automatically when you select Inferred
bus type. The parameters in the Optional Ports and Settings tab of this
dialog box can be left with their default values.

5. Click OK.

6. Draw a connection line from the top left of the Product block to the line between
the Delay and SinDelay blocks.

Add the StreamMod and StreamBit Blocks

To add the StreamMod and StreamBit blocks, follow these steps:

1. Select the IO & Bus library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Drag and drop two Output blocks into your model, positioning them to the right of
the Product block.

3. Click the text under the block symbols in your model. Change the block instance
names from Output and Outputl to StreamMod and StreamBit.

4. Double-click the StreamMod block to display the Block Parameters dialog box.
5. Set the StreamMod block parameters (Table 2-11).

Table 2-11. Parameters for the StreamMod Block

Parameter Value
Bus Type Signed Integer
[number of bits].[] 19
External Type Inferred
6. Click OK.
DSP Builder Handbook June 2012  Altera Corporation
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7. Double-click the StreamBit block to display the Block Parameters dialog box
(Figure 2-6).

Figure 2-6. Set a Single-Bit Output Bus

E Function Block Parameters: StreamBit
Output AlteraBlockset [maszk] (link]
Olutput Port

In gimulation, thiz block casts a DSP Builder internal zignal to a Simulink signal.
Choose from signed integer, unsigned integer, signed fractional representation or allow
the type to be inferred fram the previous block.

When generating hardware, thiz block gensrates an output part,

Paramesters

Bus Type|Single Bit w
[Murnber OF Bitz].[]

ls]

[1.[Mumber OF Bitz]

a

Estemal Type Inferred w

[ ak. H Cancel H Help Apply

8. Set the StreamBit block parameters (Table 2-12).

Table 2-12. Parameters for the StreamBit Block

Parameter Value
Bus Type Single Bit
External Type Inferred

9. Draw connection lines from the right side of the Product block to the left side of
the StreamMod block, and from the right side of the Bus Builder block to the left
side of the StreamBit block.

Add the Scope Block

To add the Scope block, follow these steps:
1. Select the Simulink Sinks library in the Simulink Library Browser.

2. Drag and drop a Scope block into your model and position it to the right of the
StreamMod block.

3. Double-click the Scope block and click the Parameters || icon to display the
‘Scope’ parameters dialog box.

4. Set the Scope parameters (Table 2-13).

Table 2-13. Parameters for the Scope Block

Parameter Value
Number of axes 3
Time range auto
June 2012  Altera Corporation DSP Builder Handbook
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Table 2-13. Parameters for the Scope Block

Parameter Value
Tick labels bottom axis only
Sampling Decimation 1

5. Click OK.

6. Close the Scope.

7. Make connections to connect the complete your design as follows:

a. From the right side of the Mux block to the top left side of the Scope block.

b. From the right side of the StreamMod block to the middle left side of the Scope
block.

c. From the right side of the StreamBit block to the bottom left of the Scope block.

d. From the bottom left of the Product block to the line between the Bus Builder
block and the StreamBit block.

Figure 2-7 shows the required connections.

Figure 2-7. Amplitude Modulation Design Example
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Add a Clock Block

To add a Clock block, follow these steps:

1.

2.
3.
4.

Select the AltLab library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

Drag and drop a Clock block into your model.
Double-click on the Clock block to display the Block Parameters dialog box.
Set the Clock parameters (Table 2-14).

Table 2-14. Parameters for the Clock Block

Parameter Value
Real-World Clock Period 20
Period Unit: ns

DSP Builder Handbook
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Table 2-14. Parameters for the Clock Block

Parameter Value
Simulink Sample Time 2.5e-008
Reset Name aclr

Reset Type Active Low
Export As Qutput Pin Off

"=~ A clock block is required to set a Simulink sample time that matches the
sample time specified on the Sine Wave and Random Bitstreamblocks. If no
base clock exists in your design, a default clock with a 20ns real-world
period and a Simulink sample time of 1 is automatically created.

5. Save your model.

Simulating the Model in Simulink

To simulate your model in the Simulink software, follow these steps:

1. Click Configuration Parameters on the Simulation menu to display the
Configuration Parameters dialog box and select the Solver page (Figure 2-8 on

page 2-16).

2. Set the parameters (Table 2-15).

Table 2-15. Configuration Parameters for the singen Model

Parameter Value

Start time 0.0

Stop time 4e-6

Type Fixed-step

Solver discrete (no continuous states)
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Solver Pane in the Simulink Help.

Figure 2-8. Configuration Parameters

For detailed information about solver options, refer to the description of the

5 Configuration Parameters: singen/Configuration {Active)
[ Select: | sirlation tirme
| - Bafver
. Stark bime: | 0.0 Stop time: | de-6
-~ Data Import/Export AT AL g
- Optirnization -
E1-Diagnostics Solver options
Saliiple. Tire Type: |Fixed-step |»| Solver: |Discrete (no continuous states) | sl
Fixed-step size (fundamental sample time): | auto
Tasking and sample time options
i~-Model Referencing
LSaving Petiodic sample time constraint: Unconstrained v
-Hardware Implementation ’ o . - - T
- Model Referencing Tasking mode for periodic sample fimes: SingleTasking w|
5—‘--Si|_'nulati0'|31 'll'arget [] automatically handle rate transition for data transfer
wmbols
Custam Code [] Higher priority value indicates higher task priority
[#-Real-Time Warkshop
J Ok l ’ Cancel ] [ Help Apply

DSP B

3. Click OK.

4. Start simulation by clicking Start on the Simulation menu.

5. Double-click the Scope block to view the simulation results.
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6. Click the Autoscale icon (binoculars) to auto-scale the waveforms.

Figure 2-9 shows the scaled waveforms.

Figure 2-9. Scope Simulation Results

B scope M= X
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4
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Compiling the Design

To create and compile a Quartus II project for your DSP Builder design, and to
program your design onto an Altera FPGA, add a Signal Compiler block by
following these steps:

1. Select the AltLab library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Dragand drop a Signal Compiler block into your model.

3. Double-click the Signal Compiler block in your model to display the Signal
Compiler dialog box (Figure 2-10).

The dialog box allows you to set the target device family. For this tutorial, you can
use the default Stratix device family.
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4. Click Compile.

Figure 2-10. Signal Compiler Block Dialog Box

SPBuilder - Signal Compiler - |EI|5|

~Description

This block controls the compilation of the design.

~Parametet

Quartus II Project: singen_dspbuilderisingen.qpf

1. I Skratizx - |
Family: [ Use Board Block ko Specify Device

Dewice:  aUTO

Simple | ndvan:ed' SignalTap II| Export'
~Step 1 - Compile Design

~Step & - Select Device to Program

Scan Jtag I ;II LI
—Skep 3 - Program Device
Program |

~Messages
Info: associated documentation or information are expressly subject ﬂ
Info: tothe terms and conditions of the Altera Program License
Info; Subscription Agreement, Altera Megaore Function License
Infa: Agreement, or ather applicable license agreement, including,
Info without limitation, that your use is for the sole purpose of
Info: programming logic devices manufactured by Alkera and sold by
Info: Altera or its authorized distribukors, Please refer to the
Info: applicable agreement For Further details,
Infa: Processing started: Wed Mar 18 14:56:24 2009
Info: Cormrmand: quartus_asm singesn
Info: Assembler is generating device programming files
Info: Quartus 1T Assembler was successhul, O ervors, 0 warnings
Info: Peak virtual memory; 224 megabytes
Infa: Processing ended: Wed Mar 18 14:56:30 2009
Infa: Elapsed time: 00:00:06
Info: Total CPU time {on all processors): 00:00:03 j
-

oK | Cancel |

5. When the compilation completes successfully, click OK.

6. Click Save on the File menu to save your model.

Performing RTL Simulation

To perform RTL simulation with the ModelSim software, add a TestBench block, by
following these steps:

1. Select the AltLab library from the Altera DSP Builder BlockSet folder in the
Simulink Library Browser.

2. Drag and drop a TestBench block into your model.
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3. Double-click on the new TestBench block.

The Testbench Generator dialog box appears (Figure 2-11).

Figure 2-11. Testhench Generator Dialog Box

EA bspBuilder - Testbench Generator - singen 10| =l
—Description
This block controls automatic generation of the test bench, Enabling kestbench generation may show
simulation as all input and output values are stored to file,
~Parameters
[+ Enable Test Bench generation.
Sirnple: I Advanced | Configuration |
Compare against HOL | Compare Simulink simulation against ModelSim
~Messages
=
[
oK | Cancel |
4. Ensure that Enable Test Bench generation is on.
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5. Click the Advanced tab (Figure 2-12).

Figure 2-12. Testhench Generator Dialog Box Advanced Tah
1ol x|

~Description

This block controls automatic generation of the test bench. Enabling testbench generation may slow
simulation as all input and output values are stored to file,

~Parameters
[v Enable Test Bench generation,

Simple  Advanced | Configuration

Generate WHOL Test Bench From simulink model.
Run Simulink. Rerun Sirmulink Simulation,
Run Modelsirm Launch Test Bench in MadelSim. W Launch GlUI
Compare Results Compare Simulink and MadelSim results.
—Messages
E RS (= N LC L PE= [N R [ R - [N W R RN (0| gy W~ N Pl Bl s s DY - 1A d

Info: Elaborating entity "alt_dspbuilder_SBF" For hierarchy
"singen_GM:auta_inst|alt_dspbuilder_cast_GMDEESC7H:castl |alk_dspbuilder _SEF:Oubput”
Info: Elaborating entity "alt_dspbuilder _cast_GMRGISTEMM" For hierarchy
"singen_GM:auto_inst|alt_dspbuilder _cast_GMRGISTENM:castz"
Info: Elaborating entity "alt_dspbuilder_SBF" For hierarchy
"singen_GM:auta_inst|alt_dspbuilder _cast_GMRGISTEMM:castz|alk_dspbuilder _SEFOutput”
Info: Elaborating entity "alt_dspbuilder_saltrPropagate” For hisrarchy
"singen_GM:auto_inst|alt_dspbuilder _cast_GMRGISTENMicastZ|alk_dspbuilder _SEF:Outputi]alt
_dspbuilder_saltrPropagate:ud”
Info: Quartus II Analysis & Elaboration was successful, O errors, 7 warnings

Info: Peak virtual memory; 220 megabytes

Infa: Processing ended: Wed Mar 18 15:04:12 2009

Info: Elapsed time: 00:00:10

Info: Total CPU time {on all processors): 00:00:03
Info: Creating ModelSim testbench script,
Info: Generating simulation models, j

-

oK | Cancel |

6. Turn on the Launch GUI option. This option causes the ModelSim GUI to launch
when you invoke the ModelSim simulation.

7. Click Generate HDL to generate a VDHL-based testbench from your model.
8. Click Run Simulink to generate Simulink simulation results for the testbench.
9. Click Run ModelSim to load your design into ModelSim.

Your design simulates with the output displaying in the ModelSim Wave window.
The testbench initializes all your design registers with a pulse on the aclr input
signal.

10. All waveforms initially show using digital format in the ModelSim Wave window.
Change the format of the sinin, sindelay and streammod signals to analog.

=~ InModelSim 6.4a, you can right-click to display the popup menu, point to
Format and click on Analog (Automatic). The user interface commands
may be different in other versions of ModelSim.
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11. Click Zoom Full on the right button pop-up menu in the ModelSim Wave window.
The simulation results display as an analog waveform (Figure 2-13).

Figure 2-13. Analog Display
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The introductory DSP Builder tutorial is complete. The next section shows how you
can add a DSP Builder design to a new or existing Quartus II project.

Subsequent chapters in this user guide provide examples that illustrate some of the
additional design features supported by DSP Builder.

Adding the Design to a Quartus Il Project

DSP Builder uses the Quartus II project created by the Signal Compiler block. This
section describes how to add your design to a new or existing Quartus II project.

Before you follow these steps, ensure that your design is compiled with the Signal
Compiler block (“Compiling the Design” on page 2-17).

Creating a Quartus Il Project
To create a new Quartus II project:
1. Start the Quartus II software.

2. Click New Project Wizard on the File menu in the Quartus II software and specify
the working directory for your project. For example, D:\MyQuartusProject.

3. Specify the name of the project. For example, NewProject and the name of the
top-level design entity for the project.
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=~ The name of the top-level design entity typically has the same name as the
project.
Click Next to display the Add Files page. There are no files to add for this tutorial.

Click Next to display the Family & Device Settings page and check that the
required device family is selected. This should normally be the same device family
as specified for Signal Compiler in “Compiling the Design” on page 2-17.

Click Finish to close the wizard and create the new project.

= When you specify a directory that does not already exist, a message asks if
the specified directory should be created. Click Yes to create the directory.

Add the DSP Builder Design to the Project

To add your DSP Builder design to the project in the Quartus II software:

1.

DSP Builder Handbook

On the View menu in the Quartus II software, point to Utility Windows and click
Tcl Console to display the Tcl Console.

Run the singen_add.tcl script that can be found in the <DSP Builder install
path>\DesignExamples\ Tutorials\ GettingStartedSinMd]l directory by typing
the following command in the Tcl Console window:

# source <install path>/DesignExamples/Tutorials/GettingStartedSinMdl/s
ingen add.tcl

"=~ Youmust use / separators instead of \ separators in the command path
name used in the Tcl console window. You can use a relative path if you
organize your design data with the DSP Builder and Quartus II designs in
subdirectories of the same design hierarchy.

An example instantiation is added to your Quartus II project.

Click the Files tab in the Quartus II software.

Right-click singen.mdl and click Select Set as Top-Level Entity.

Compile the Quartus II design by clicking Start Compilation on the Processing

menu.

"=~ You can copy the component declaration from the example file for your
own code.
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3. Design Rules and Procedures

This chapter discusses the following topics:

“DSP Builder Naming Conventions”

“Using a MATLAB Variable”

“Fixed-Point Notation”

“Bit Width Design Rule”

“Frequency Design Rules”

“Timing Semantics Between Simulink and HDL Simulation”
“Signal Compiler and TestBench Blocks”

“Hierarchical Design”

“Goto and From Block Support”

“Create Black Box and HDL Import”

“Using a MATLAB Array or .hex File to Initialize a Block”
“Comparison Utility”

“Adding Comments to Blocks”

“Adding Quartus II Constraints”

“Displaying Port Data Types”

“Displaying the Pipeline Depth”

“Updating HDL Import Blocks”

“Analyzing the Hardware Resource Usage”

“Loading Additional ModelSim Commands”

“Making Quartus II Assignments to Block Entity Names”

DSP Builder Naming Conventions

DSP Builder generates VHDL files for simulation and synthesis. When there are
blocks or ports in your model that share the same VHDL name, they are given unique
names in the VHDL to avoid name clashes. However, clock and reset ports are never
renamed, and an error issues if they do not have unique names. Avoid name clashes
on other ports, to avoid renaming of the top-level ports in the VHDL.

All DSP Builder port names must comply with the following naming conventions:

June 2012  Altera Corporation

VHDL is not case sensitive. For example, the input port MyInput and MYINPUT is the
same VHDL entity.

Avoid using VHDL keywords for DSP Builder port names.

Do not use illegal characters. VHDL identifier names can contain only a-z,0-9,
and underscore (_) characters.

DSP Builder Handbook
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I =
i=

m Begin all port names with a letter (a - z). VHDL does not allow identifiers to begin
with non-alphabetic characters or end with an underscore.

m Do not use two underscores in succession (__) in port names because it is illegal in
VHDL.

White spaces in the names for the blocks, components, and signals are converted to an
underscore when DSP Builder converts the Simulink model file (.mdl) into VHDL.

Using a MATLAB Variable

I =
i=

You can specify many block parameters (such as bit widths and pipeline depth) by
entering a MATLAB base workspace or masked subsystem variable. You can then set
these variables on the MATLAB command line or from a script. DSP Builder evaluates
the variable and passes its value to the simulation model files. DSP Builder ensures
that the parameters are in the required range.

Although DSP Builder no longer restricts parameters to 51 bits, MATLAB evaluates
parameter values to doubles, which restricts the possible values to 51-bit numbers
expressible by a double.

For information about which values are parameterizable, refer to the DSP Builder
Standard Blockset Libraries section in volume 2 of the DSP Builder Handbook or to the
block descriptions, which you can access with the Help command in the right button
pop-up menu for each block.

Fixed-Point Notation

Figure 3-1 describes the fixed-point notation that I/O formats use in the DSP Builder
block descriptions.

Table 3-1. Fixed-Point Notation

Description

Notation SlmuIlnk-to(}l)in(Lz')l'ranslatlon

Signed binary:
fractional (SBF)
representation; a
fractional number

[L].[R] where: sign bit

[L] is the number of bits to the left of

the binary point and the MSB is the o ) )
A Simulink SBF signal A[L].[R] maps in VHDL to

, , , STD_LOGIC_VECTOR(L + R - 1} DOWNTO 0)
[R] is the number of bits to the right

of the binary point

Signed binary;
integer (INT)

[L] where: signed bus and the MSB is the sign

[L] is the number of bits of the A Simulink signed binary signal A[L] maps to

STD_LOGIC_VECTOR({L - 1} DOWNTO 0)

bit
Unsigned binary; (L] where: [L] is the number of bits of the A Simulink unsigned binary signal A[L] maps to
integer (UINT) ' unsigned bus STD_LOGIC_VECTOR({L - 1} DOWNTO 0)

DSP Builder Handbook
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Fixed-Point Notation

Table 3-1. Fixed-Point Notation

Description Notation Simll|i“k-tll(-1|)|IJI(-Z')I'ransIatiun
Single bit integer . . . A Simulink single bit integer signal maps to
(BIT) [1] where: the single bit can have values 1 or 0 STD._LOGIC

Notes to Table 3-1:

(1) STD_LOGIC_VECTOR and STD_LOGIC are VHDL signal types defined in the (ieee.std_logic_1164.all and ieee.std_logic_signed.all |[EEE

library packages).

(2) For designs in which unsigned integer signals are used in Simulink, DSP Builder translates the Simulink unsigned bus type with width winto a
VHDL signed bus of width w + 1 where the MSB bit is set to 0.

Figure 3-1 graphically compares the signed binary fractional, signed binary, and
unsigned binary number formats.

Figure 3-1. Number Format Gomparison

[4].[4] Signed Binary Fractional Notation

AOnbuono

2

8-Bit Signed Integer

L? G 5 4 3 2 1 o

1— Sign Bit

8-Bit Unsigned Integer

7 G 5 4 3 2 1 0

Binary Point Location in Signed Binary Fractional Format

For hardware implementation, you must cast Simulink signals into the desired
hardware bus format. Therefore, convert floating-point values to fixed-point values.

This conversion is a critical step for hardware implementation because the number of
bits required to represent a fixed-point value plus the location of the binary point
affects both the hardware resources and the system accuracy.

Choosing a large number of bits gives excellent accuracy—the fixed-point result is
almost identical to the floating-point result—but consumes a large amount of
hardware. You must design for the optimum size and accuracy trade-off. DSP Builder
speeds up your design cycle by enabling simulation with fixed-point and
floating-point signals in the same environment.

The Input block casts floating-point Simulink signals of type double into fixed-point
signals. DSP Builder represents the fixed-point signals in the following signed binary
fractional (SBF) format:

B [number of bits].[[—represents the number of bits to the left of the binary point
including the sign bit.
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m  [].[number of bits]—represents the number of bits to the right of the binary point.
In VHDL, DSP Builder types the signals as STD_LOGIC_VECTOR.
For example, DSP Builder represents the 4-bit binary number 1101 as:
SimulinkThis signed integer is interpreted as -3
VHDLThis signed STD_LOGIC_VECTOR is interpreted as -3

If you change the location of the binary point to 11.01, that is, two bits on the left side
of the binary point and two bits on the right side, DSP Builder represents the numbers
as:

SimulinkThis signed fraction is interpreted as —0.75
VHDLThis signed STD_LOGIC_VECTOR is interpreted as -3

From a system-level analysis point of view, multiplying a number by —-0.75 or -3 is
very different, especially when looking at the bit width growth. In the first case, the
multiplier output bus grows on the most significant bit (MSB), in the second case, the
multiplier output bus grows on the least significant bit (LSB).

In both cases, the binary numbers are identical. However, the location of the binary
point affects how a simulator formats the representation of the signal. For complex
systems, you can adjust the binary point location to define the signal range and the
area of interest.
“ e For more information about number systems, refer to AN 83: Binary Numbering
Systems.

Bit Width Design Rule

You must specify the bit width at the source of the datapath. DSP Builder propagates
this bit width from the source to the destination through all intermediate blocks. Some
intermediate DSP Builder blocks must have a bit width specified, while others have
specific bit width growth rules which are described in the documentation for each
block.

Some blocks which allow bit widths to be specified optionally, have an Inferred type
setting that allows a growth rule to be used. For example, in the amplitude
modulation tutorial design (Chapter 2, Getting Started) the SinIn and SinDelay
blocks have a bit width of 16. Therefore, a bit width of 16 is automatically assigned to
the intermediate Delay block.

Data Width Propagation

You can specify the bit width of many Altera blocks in the Simulink design. However,
you do not need to specify the bit width for all blocks. If you do not specify explicitly
the bit width, DSP Builder assigns a bit width during the Simulink-to-VHDL
conversion by propagating the bit width from the source of a datapath to its
destination.

Some intermediate DSP Builder blocks must have a specified bit width, while others
have specific bit width growth rules that the documentation for each block describes.
Some blocks, which allow bit widths to be specified optionally, allow use of a growth
rule—the Inferred type setting.

DSP Builder Handbook June 2012  Altera Corporation
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Figure 3-2 illustrates bit-width propagation.

Figure 3-2. 3-Tap FIR Filter

(O —» 7o ® 3

In1 Input

s B
D lay1
2 S
Lelay2 GHain2

The fir3tapsub.mdl design is a 3-tap finite impulse response (FIR) filter and has the
following attributes:

m The input data signal is an 8-bit signed integer bus
m The output data signal is a 20-bit signed integer bus
m Three Delay blocks build the tapped delay line

m The coefficient values are {1.0000, -5.0000, 1.0000}, a Gain block performs the
coefficient multiplication

Figure 3-3 shows the RTL representation of fir3tapsub.mdl created by Signal
Compiler.

Figure 3-3. 3-Tap FIR Filter in Quartus Il RTL View
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Tapped Delay Line

The bit width propagation mechanism starts at the source of the datapath, in this case
at the Input block, which is an 8-bit input bus. This bus feeds the register U0, which
feeds U1, which feeds U2. DSP Builder propagates the 8-bit bus in this register chain

where each register is eight bits wide (Figure 3—4).

Figure 3-4. Tap Delay Line in Quartus Il Version RTL Viewer
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Arithmetic Operation

Figure 3-5 shows the arithmetic section of the filter, that computes the output yout:

2
youtl[k] = Z x[k—1]c[i]
i=0
where c[i] are the coefficients and x[k - i] are the data.

Figure 3-5. 3-Tap FIR Filter Arithmetic Operation in Quartus Il Version RTL Viewer
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This design requires three multipliers and one parallel adder. The arithmetic
operations increase the bus width in the following ways:

m  Multiplying a x b in SBF format (where [ is left and r is right) is equal to:
[la].[ra] x [Ib].[rb]
The bus width of the resulting signal is:
([la] + [I0])-([ra] + [rB])
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m Addinga + b + c in SBF format (where [ is left and r is right) is equal to:
[la].[ra] + [ID].[rb] + [lc].[rc]
The bus width of the resulting signal is:
(max([la], [Ib], [Ic]) + 2).(max([ral, [rb], [rc]))

The parallel adder has three input buses of 14, 16, and 14 bits. To perform this
addition in binary, DSP Builder automatically sign extends the 14-bit busses to 16 bits.
The output bit width of the parallel adder is 18 bits, which covers the full resolution.

The following options can change the internal bit width resolution and therefore
change the size of the hardware required to perform the function that Simulink
describes:

m Change the bit width of the input data.

m Change the bit width of the output data. The VHDL synthesis tool removes any
unused logic.

m InsertaBus Conversion block to change the internal signal bit width.

Figure 3-6 shows how you can use Bus Conversion blocks to control internal bit
widths.

Figure 3-6. 3-Tap Filter with BusConversion to Control Bit Widths

'
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Input

Bus Conversion

Bus Conversion 1

Bus Conversion2

Celay2 Gain2

I =
=

In Figure 3-6, the output of the Gain block has 4 bits removed. Port data type display
is enabled in this example and shows that the inputs to the Delay blocks are of type
INT_8 but the outputs from the Bus Conversion blocks are of type INT 6.

You can also achieve bus conversion by inserting an A1tBus, Round, or Saturate block.
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The RTL view illustrates the effect of this truncation. The parallel adder required has a
smaller bit width and the synthesis tool reduces the size of the multiplier to have a
9-bit output (Figure 3-7).

Figure 3-7. 3-Tap Filter with BusGonversion to Control Bit Widths in Quartus Il RTL Viewer
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e For more information, refer to “Fixed-Point Notation” on page 3-2.

Frequency Design Rules

This section describes the frequency design rules for single and multiple clock
domains.

Single Clock Domain

DSP Builder Handbook

If your design does not contain a PLL block or Clock Derived block, DSP Builder uses
synchronous design rules to convert a Simulink design into hardware. All DSP
Builder registered blocks (such as the Delay block) operate on the positive edge of the
single clock domain, which runs at the system sampling frequency.

The clock pin is not graphically displayed in Simulink unless you use the Clock block.
However, when DSP Builder converts your design to VHDL it automatically connects
the clock pin of the registered blocks (such as the Delay block) to the single clock
domain of the system.

The default clock pin is named clock and there is also a default active-low reset pin
named aclr.

By default, Simulink does not graphically display the clock enable and reset input
pins of the DSP Builder registered blocks. When DSP Builder converts a design to
VHDL, it automatically connects these pins. You can access and drive these optional
ports by checking the appropriate option in the Block Parameters dialog box.

Simulink issues a warning if you are using an inappropriate solver for your model.

You should set the solver options to fixed-step discrete when you are using a single
clock domain.
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For Simulink simulation, all DSP Builder blocks (including registered DSP Builder
blocks) use the sampling period specified in the Clock block. If there is no Clock block
in your design, the DSP Builder blocks use a sampling frequency of 1. You can use the
Clock block to change the Simulink sample period and the hardware clock period.

Multiple Clock Domains

A DSP Builder model can operate using multiple Simulink sampling periods. You can
specify the clock domain in some DSP Builder block sources, such as the Counter
block. You can also specify the clock domain in DSP Builder rate change blocks such
as Tsamp.

When using multiple sampling periods, DSP Builder must associate each sampling
period to a physical clock domain that can be available from an FPGA PLL or a clock
input pin. Therefore, the top-level DSP Builder model must contain DSP Builder rate
change blocks such as PLL or Clock_Derived.

You can use a PLL block to synthesize additional clock signals from a reference clock
signal. These internal clock signals are multiples of the system clock frequency.

Refer to “Using the PLL Block” on page 3-14 for more information.

If your design contains the PLL block, Clock or Clock Derived blocks, the DSP Builder
registered blocks operate on the positive edge of one of the block’s output clocks.

You must set a variable-step discrete solver in Simulink when you are using multiple
clock domains.

To ensure a proper hardware implementation of a DSP Builder design using multiple
clock domains, consider the following points:

B Do not use DSP Builder combinational blocks for rate transitions to ensure that the
behavior of the DSP Builder Simulink model is identical to the generated RTL
representation.

Figure 3-8 illustrates an incorrect use of the DSP Builder Logical Bit Operator
(NOT) block.

Figure 3-8. Example of Incorrect Usage: Mixed Sampling Rate on a NOT Block
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m Two DSP Builder blocks can operate with two different sampling periods.
However for most DSP Builder blocks, the sampling period of each input port and
each output port must be identical.

Although this rule applies most of the DSP Builder blocks, there are some
exceptions such as the Dual-Clock FIFO block where the sampling period of the
read input port is expected to be different than the sampling period of the write
input port.

m For a datapath using mixed clock domains, the design may require additional
register decoupling around the register that is between the domains.

This requirement is especially true when the source data rate is higher than the
destination register, in other words, when the data of a register is toggling at the
higher rate than the register’s clock pin (Figure 3-9).

Figure 3-9. Data Toggling Faster than Clock
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Figure 3-10 shows a stable hardware implementation.
Figure 3—-10. Stahle Hardware Implementation
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Using Clock and Clock_Derived Blocks

DSP Builder maps the Clock and Clock Derived blocks to two hardware device input
pins; one for the clock input, and one for the reset input for the clock domain. A
design may contain zero or one Clock block and zero or more Clock Derived blocks.

DSP Builder Handbook June 2012  Altera Corporation
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If you use Clock Derived blocks, and there is only one system clock, you must
generate an appropriate clock signal for connection to the hardware device input pins
for the derived clocks.

The Clock block defines the base clock domain, and Clock Derived blocks define
other clock domains. DSP Builder specifies sample times in terms of the base clock
sample time. If there is no Clock block, DSP Builder uses a default base clock, with a
Simulink sample time of 1, and a hardware clock period of 20 us.

This feature is available across all device families that DSP Builder supports. If no
Clock block is present, the design uses a default clock pin named clock and a default
active-low reset pin named aclr.

The signal Compiler block assigns a clock buffer and a dedicated clock-tree to
clock-signal input pin automatically to maintain minimum clock skew. If your design
contains more Clock and Clock Derived blocks than there are clock buffers available,
non dedicated routing resources route the clock signals.

Clock Assignment

DSP Builder identifies registered DSP Builder blocks such as the Delay block and
implicitly connects the clock, clock enable, and reset signals in the VHDL design for
synthesis. When your design does not contain a Clock block, Clock_Derived block, or
PLL block, all the registered DSP Builder block clock pins connect to a single clock
domain (signal clock in VHDL).

Define clock domains by the clock source blocks: the Clock block, the Clock Derived
block and the PLL block.

The Clock block defines the base clock domain. You can specify its Simulink sample
time and hardware clock period directly. If there is no Clock block, there is a default
base clock with a Simulink sample time of 1. You can use the Clock_Derived block to
define clock domains in terms of the base clock. DSP Builder specifies the sample time
of a derived clock as a multiple and divisor of the base clock sample time.

The PLL block maps to a hardware PLL. You can use it to define multiple clock
domains with sample times specified in terms of the PLL input clock. Use the PLL
input clock either as the base clock or a derived clock.

Each clock domain has an associated reset pin. The Clock block and each of the
Clock_Derived blocks have their own reset pin, the name of which is in the block's
parameter dialog box. The clock domains of the PLL block share the reset pin of the
PLL block's input clock.

When your design contains clock source blocks, DSP Builder implicitly connects the
clock pins of all the registered blocks to the appropriate clock pin or PLL output. DSP
Builder also connects the reset pins of the registered blocks to the top-level reset port
for the block's clock domain.

DSP Builder blocks fall into the following clocking categories:

m Combinational blocks—the output always changes at the same sample time slot as

the input.
m Registered blocks—the output changes after a variable number of sample time
slots.
June 2012  Altera Corporation DSP Builder Handbook
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Figure 3-11 illustrates DSP Builder block combinational behavior.

Figure 3-11. Magnitude Block: Combinational Behavior
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The Magnitude block translates as a combinational signal in VHDL. DSP Builder does
not add clock pins to this function.

Figure 3-12 illustrates the behavior of a registered DSP block. In the VHDL netlist,
DSP Builder adds clock pin inputs to this function. The Delay block, with the Clock
Phase Selection parameter equal to 100, is converted into a VHDL shift register with a

decimation of three and an initial value of zero.

Figure 3-12. Delay Block: Registered Behavior
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3-13

For feedback circuitry (the output of a block fed back into the input of a block), a
registered block must be in the feedback loop. Otherwise, DSP Builder creates an
unresolved combinational loop (Figure 3-13).

Figure 3-13. Feedback Loop
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Use the PLL block and assign different sampling periods on registered DSP Builder
blocks to design multirate designs.

Alternatively, use a single clock domain with clock enable and the following design
rules to design multirate designs without the DSP Builder PLL block:

m The fastest sample rate is an integer multiple of the slower sample rates. The Clock
Phase Selection field in the Block Parameters dialog box specifies the values for

the Delay block.

The Clock Phase Selection box accepts a binary pattern string to describe the
clock phase selection. DSP Builder processes each digit or bit of this string
sequentially on every cycle of the fastest clock. When a bit is equal to one, DSP
Builder enables the block; when a bit is equal to zero, DSP Builder disables the
block.

Table 3-2 shows some examples of typical clock phase selections.

Table 3-2. Clock Phase Selection Example

Phase Description

1 The Delay block is always enabled and captures all data passing through the block
(sampled at the rate 1).

10 The Delay block is enabled every other phase and every other data (sampled at the
rate 1) passes through.
The Delay block is enabled on the 2nd phase out of 4 and only the 2nd data out of 4

0100 (sampled at the rate 1) passes through. The data on phases 1, 3, and 4 does not pass
through the Delay block.

June 2012  Altera Corporation
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Figure 3-14 compares the scopes for the Delay block operating at a one quarter rate on
the 1000 and 0100 phases, respectively.

Figure 3-14. 1000 as Opposed to 0100 Phase Delay
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Using the PLL Block

DSP Builder maps the PLL block to the hardware device PLL. The number of PLL
internal clock outputs that each device family supports depends on the specific device
packaging.

“%e Forinformation about the built-in PLLs, refer to the device handbook for the device

family you are targeting.

Figure 3-15 shows an example of multiple-clock domain support using the PLL block.

Figure 3-15. MultipleClockDelay.mdl
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Figure 3-16 shows the clock setting configuration for the PLL block in the design
example MultipleClockDelay.mdl. Output clock PLL_c1k0 is set to 800 ns, and output
clock PLL clk1 is set to 100 ns.

Figure 3-16. PLL Setting
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Datapath A (green in Figure 3-15) operates on output clock PLL_c1k0 and datapath B
(red in Figure 3-15) operates on output clock PLL_c1k1. Specify these clocks by setting
the Specify Clock option and enter the clock name in the Block Parameter dialog box
for each input block.

In this design, the Sample time parameters for the Sine Wave ablock and Sine Wave
b block are set explicitly to 1e-006 and 1e-007, so that DSP Builder provides data to the
input blocks at the rate at which they sample.

Using Advanced PLL Features

The DSP Builder PLL block supports the fundamental multiplication and division
factor for the PLL. If you want to use other PLL features (such as phase shift, duty
cycle), use a separate Quartus II project with the following method:

m Create a new Quartus II project and use the MegaWizard™ Plug-In to configure
the ALTPLL block.

B Add the DSP Builder .mdl file to the Quartus II project as a source file.

m Create a top-level design that instantiates your ALTPLL variation and your DSP
Builder design.
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Timing Semantics Between Simulink and HDL Simulation

DSP Builder uses Simulink to simulate the behavior of hardware components.
However, there are some fundamental differences between the step-based simulation
in Simulink and the event-driven simulation that VHDL and Verilog HDL designs
use.

This section describes the timing semantics that DSP Builder uses for translating
between the Simulink and HDL environments.

Simulink Simulation Model

To ensure correlation between the HDL and Simulink simulation, you must use a
discrete fixed or variable-step solver in Simulink.

Use a fixed-step solver for a single clock domain design or a variable-step solver for
multiple-clock domain designs.

Configure the solver timing mode in the Configuration Parameters dialog box from
the Simulation menu in Simulink. Each step is a discrete unit of simulation. DSP
Builder quantizes the clock in an idealized manner as a cycle counter.

At the beginning of each step, Simulink provides each block with inputs that you
know. DSP Builder evaluates functions and propagates the resultant outputs in the
current step. The outputs of your model are the results of all these computations.

For all steps, Simulink blocks produce output signals. Outputs varying based on
inputs received in the same step are referred to as direct feedthrough. Some DSP
Builder blocks may include direct feedthrough outputs, depending on the
parameterization of each block.

HDL Simulation Models

I =
i=

DSP Builder Handbook

DSP Builder drives hardware simulation with a clock signal and the available input
stimuli. The TestBench block” s testbench script feeds input signals to the HDL
simulator that maintain correlation between the HDL and Simulink simulation.

Simulation models in the DSP Builder libraries evaluate their logic on positive clock
edges. To avoid any timing conflicts, external inputs transition on negative clock
edges. DSP Builder updates registered outputs on positive clock edges. The TestBench
block-generated inputs arrive on negative clock edges, causing an apparent half-cycle
delay in the arrival of output (Figure 3-17 on page 3-18).

The HDL simulation in ModelSim should run over the same time as the Simulink
simulation. Generally DSP Builder aligns the timing so that ModelSim simulation
finishes at the end of the stimulus data. However, occasionally when using multiple
clocks, the rounding calculation that aligns the clock signals may set ModelSim
simulation to run for one additional clock cycle (on the fastest clock). You may receive
an unexpected end of file error message because there is no stimulus data for this
extra cycle.
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Startup & Initial Conditions

i

The testbench includes a global reset for each clock domain. All blocks (except the HDL
Import and MegaCore function blocks) automatically connect any reset on the
hardware to the global asynchronous reset for the clock domain.

When a block explicitly declares an asynchronous reset, this reset is ORed with the
global reset.

A Global Reset block (SCLR), which corresponds to this hardware signal is in the
Altera DSP Builder Blockset IO & Bus library.

The global reset signal is reset before meaningful simulation. When converting from
the Simulink domain to the hardware domain, the reset period is before the Simulink
simulation begins. Therefore, in Simulink simulation, the Global Reset block outputs
only a constant zero and has no simulation behavior. Connect the hardware to reset,
and thus reset at the start of a ModelSim testbench simulation.

DSP blocks or MegaCore functions may have additional initial conditions or startup
states that are not automatically reset by the global reset signal.

Initial Reset of HDL Import Blocks and MegaCore Functions in Simulink
Simulations

The ModelSim testbenches have an initial reset cycle, which ModelSim performs,
before simulation. The first 200 cycles are reset, then the testbench puts the test vectors
through. The reset sets the intial state of registers, which may otherwise have X'
(unknown) outputs. In Simulink simulations, there is no explicit reset signal—the
Simulink simulation models for DSP Builder blocks assume there is a reset. HDL
import blocks and MegaCore functions do not provide explicit models, but use a
generic HDL simulator. Simulink does not have a way to represent 'X' in its numeric
types— it writes an unknown 'X' as a 0. The HDL import block or MegaCore function
may have registers that require a reset to avoid unknown outputs. Unknown states
may be initially propagating through your imported HDL import block or MegaCore
function. For some imported HDL import blocks or MegaCore functions, these initial
unknown outputs may result in outputs that are different to the ModelSim simulation
(which is reset).

Altera recommends that you must first explicitly reset HDL import blocks and
MegaCore functions in Simulink simulation. If you have any such registers with
unknown outputs in a feedback loop, the Simulink simulation always gives X' (zero
in Simulink's numeric types) until reset and the unknown states continue to
propagate.

If a block in one clock domain drives a block in another clock domain with an
asynchronous clear port, Simulink may not model the system. An asynchronous clear
only takes full effect if you assert it at the end of a sample; if it is asserted then cleared,
DSP Builder ignores it.

DSP Builder Global Reset Circuitry

By default, Simulink does not graphically display the clock enable and reset input
pins on DSP Builder registered blocks. When DSP Builder converts a design to HDL, it
automatically connects the implied clock enable and reset pins.
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If you turn on the optional ports in the Block Parameters dialog box for each of the
DSP Builder registered blocks, you can access and drive the clock enable and reset
input pins graphically in the Simulink software.

In the HDL domain, the registered DSP Builder blocks uses an asynchronous reset, as
this behavioral VHDL code example shows:

process (CLOCK, RESET)

begin
if RESET = '1l' then
dout <= (others => '0');
else if CLOCK'event and CLOCK = '1l' then
dout <= din;
end if;
end

In addition, when targeting a development board, the Block Parameters dialog box
for the DSP Board configuration block typically includes a Global Reset Pin selection
box where you can choose from a list of pins that correspond to the DIP and
push-button switches.

The reset logic polarity can be either active-high or active-low. When you select
active-low, the value of the reset signal in Simulink simulation is still O for inactive
and 1 for active. However, DSP Builder inserts a NOT gate on the input pin in the
generated hardware. The value of the reset signal in simulation is therefore the value
as it exists across the internal design, rather then the value at the input pin.

Quartus® II synthesis interprets this reset as an asynchronous reset, and uses an input
of the logic element look-up table to instantiate the function. The HDL simulates
correctly in this case because the testbench produces the reset input as required.

Reference Timing Diagram

Figure 3-17 shows the timing relationships in a hypothetical case where a register is
fed by the output of a counter. The counter output begins at 10—the value is 10 during
the first Simulink clock step.

Figure 3-17. Single-Clock Timing Relationships
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This timing is not true when crossing clock domains. For example, Figure 3-18 shows
the timing delays in a design with a derived clock that has half the base clock period.
In general, DSP Builder is not cycle-accurate when crossing clock domains.

Figure 3-18. Multiple-Clock Timing Relationships
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Signal Compiler and TestBench Blocks

The signal Compiler block uses Quartus II synthesis to convert a Simulink design
into synthesizable VHDL including generation of a VHDL testbench and other
supporting files for simulation and synthesis.

Signal Compiler assumes that your design complies with the Simulink rules and that
any variables and inherited variables propagate through the whole design.

You should always run a simulation in Simulink before running Signal Compiler.
The simulation updates all variables in your design (including workspace variables
and inherited parameters), sets up certain blocks (such as the memory blocks, and
inputs from and outputs to workspace blocks), and also traps any design errors that
do not comply with Simulink rules.

The Input and Output blocks map to input and output ports in VHDL and mark the
edge of the generated system. Typically, you connect these blocks to the Simulink
simulation blocks for your testbench. An Output block should not connect to another
Altera block. If you connect more Altera blocks (that map to HDL), empty ports are
created and the HDL does not compile for synthesis.
“ e For more information about the Input and Output blocks, refer to the IO & Bus Library
chapter of the DSP Builder Reference Manual.

Design Flows for Synthesis, Compilation and Simulation

You can use the Signal Compiler and Testbench blocks to control your design flow
for synthesis, compilation, and simulation. DSP Builder supports the following flows:
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B Automatic flow—allows you to control the entire design process in the MATLAB

or Simulink environment with the Signal Compiler block. With this flow, your
design compiles inside a temporary Quartus II project. The results of the synthesis
and compilation display in the Signal Compiler Messages box. You can also use
the automatic flow to download your design into supported development boards.

Manual flow—you can also add the .mdl file to an existing Quartus II project
using the <model name>_add.tcl script. This script is generated whenever the
Signal Compiler or TestBench block is run. You can use the script to add the .mdl
file and any imported HDL to your project. You can then instantiate your design in
HDL.

Simulation flow—if the ModelSim executable (vsim.exe) is on your path, you can
use the TestBench block to compile your design for ModelSim simulation. You can
then automatically compare the Simulink and ModelSim simulation results.

For an example that uses the Signal Compiler blocker, refer to page 2-14 of the
“Getting Started”.

For information about the parameters for the Signal Compiler and TestBench blocks,
refer to the AltLab Library chapter of the DSP Builder Reference Manual.

DSP Builder supports the Simulink Bus Creator, Bus Selector, and Bus Assignment
blocks but you must only use them for routing.

Hierarchical Design

DSP Builder Handbook

DSP Builder supports hierarchical design using the Simulink Subsystem block.

DSP Builder preserves the hierarchy structure in a VHDL design and each hierarchical
level in a Simulink model file (.mdl) translates into one VHDL file.
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For example, Figure 3-19 illustrates a hierarchy for a design fir3tap.mdl, which
implements two FIR filters.

Figure 3-19. Hierarchical Design Example
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“ e For information about naming the Subsystem block instances, refer to “DSP Builder
Naming Conventions” on page 3-1.

Goto and From Block Support

DSP Builder supports the Goto and From blocks from the Signal Routing folder in the
generic Simulink library.

You can use these blocks for large fan-out signals and to enhance the diagram clarity.
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Figure 3-20 shows an example of the Goto and From blocks.

Figure 3-20. Goto & From Block Example
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Use the Goto blocks ([ReadAddr], [WriteAddr], and [WriteEna] with the From blocks
([ReadAddr], [WriteAddr], and [WriteEna], which connect to the dual-port RAM blocks.

Create Black Box and HDL Import

You can add your own VHDL or Verilog HDL code to your design and specify which
subsystem block(s) DSP Builder should translate into VHDL. You can implement this

process—creating a black box—implicitly or explicitly.

An explicit black box uses the HDL Input, HDL Output, HDL Entity, and Subsystem
Builder blocks. For information about using these blocks to create an explicit black
box, refer to “Subsystem Builder Design Example” in Chapter 8.

DSP Builder Handbook
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An implicit black box uses the HDL. Import block to instantiate the black-box
subsystem. For information about creating an implicit black box with your own HDL
code, refer to the “HDL Import Design Example” in Chapter 8.

Using a MATLAB Array or .hex File to Initialize a Block

Use a MATLARB array to specify the values entered in the LUT block or to initialize the
Dual-Port RAM, Single-Port RAM, True Dual-Port RAM, or ROM blocks. You can also
use an Intel format hexadecimal format (-hex) file to initialize a RAM or ROM block.

If the MATLAB array data values or the values in the .hex file do not represent exactly
in the selected data type, DSP Builder rounds them and issues a warning. DSP Builder
rounds the values by expressing the number in binary format, then truncates to the
specified width, which results in rounding towards minus infinity.

For example, if the input value is —0.25 (minimally expressed in signed binary
fractional two’s compliment format as 111) and the selected target data format is
signed fractional [1] . [1], DSP Builder truncates the value to 11 = —0.5. DSP Builder
rounds the value towards minus infinity to the nearest representable number.

Similarly, if you select unsigned integer data type and the value is 1.9, DSP Builder
rounds this value down to 1.

Comparison Utility

DSP Builder provides a simple utility that runs simulation comparison between
Simulink and ModelSim from the command line:

alt dspbuilder verifymodel ('modelname.mdl', 'logfile.txt')+#

A testbench GUI displays messages as DSP Builder performs the comparison. The
command returns true (1) or false (0) according to whether the simulation results
match and the output is recorded in the specified log file.

“ e For more information about running a comparison between Simulink and ModelSim,
refer to “Performing RTL Simulation” in Chapter 2.
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Adding Comments to Blocks

You can add comments to any DSP Builder block by right-clicking on the block to
display the Block Properties dialog box and entering text in the Description field of
the dialog box (Figure 3-21 on page 3-24).

Figure 3-21. Adding Comments to a Block
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Tag:
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DSP Builder includes the comment text next to the instantiation of the block in the
generated HDL.

Adding Quartus Il Constraints

You can set Quartus II global project assignments in your Simulink model by adding
Quartus II Global Project Assignment blocks from the AltLab library. Each block
sets a single global assignment but you can use multiple blocks for multiple
assignments. You can use these assignments to set Quartus II compilation directives,
such as target device or timing requirements.
“%e Fora description of the Quartus II Global Project Assignment block, refer to the
DSP Builder Reference Manual.

You can add additional Quartus II assignments or constraints that are not supported
in DSP Builder by creating a Tcl script in your design directory. Any file named <model
name>_add_user.tcl is automatically sourced when you run Signal Compiler.

The Tcl file can include any number of Quartus II assignments with the syntax:
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set _global assignment -name <assignment> <value>

“ e TFor detailed information about Quartus II assignments, refer to the Quartus II Settings
File Reference Manual.

Displaying Port Data Types

You can optionally display the Simulink and DSP Builder port data types for each of
the signals in your Simulink model by turning on Port Data Types in the Port/Signal
Displays section of the Simulink Format menu.

When you set this option, the DSP Builder internal signal type (SBF_L R, INT L,
UINT_L, or BIT where L, and R are the number of bit to the left and right of the binary
point) displays. For example, SBF_8_4 for a 12-bit signed binary fractional data type
with 4 fractional bits, or UINT 16 for a 16-bit unsigned integer.

Figure 3-22 shows the amplitude modulation example with port data type display
enabled.

Figure 3-22. Tutorial Example Showing Port Data Types and Pipeline Depth
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“% e For more information about the DSP Builder internal signal types, refer to

“Fixed-Point Notation” on page 3-2.

Displaying the Pipeline Depth

You can optionally display the pipeline depth on the primitive blocks (such as the
Arithmetic library blocks) in your Simulink model by adding a Display Pipeline
Depth block from the AltLab library.

You can change the display mode by double-clicking on the block. When set, the
current pipeline depth displays at the top right corner of each block that adds latency
to your design (Figure 3-22). The selected mode shows on the Display Pipeline
Depth block symbol.
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Updating HDL Import Blocks

The HDL Import blocks in your design may need updating if you upgrade from a
previous software version or move a design to a different workstation.

You can use the alt _dspbuilder refresh hdlimport command to update these
blocks. This command checks that the referenced HDL files (or Quartus II project)
exists. If it finds the references, the HDL Import dialog box opens and a compilation is
automatically invokes to regenerate the Simulink model. If it finds neither, but there is
an existing simulation netlist, it uses this netlist for simulation.

To run the command, follow these steps:

1. Start the MATLAB or Simulink software.

2. Open a Simulink model that contains imported HDL.

3. Run the command by typing the following at the MATLAB prompt:
alt dspbuilder refresh hdlimport ¢

You can optionally select a HDL. Import block to run the command on only the selected
subsystem.

Analyzing the Hardware Resource Usage

DSP Builder Handbook

To analyze the hardware resources required for your design with a Resource Usage
block, follow these steps:

1. Select the AltLab library from the Altera DSP Builder BlockSet folder in the
Simulink Library Browser.

2. Drag and drop a Resource Usage block into your model and double-click on the
block to open the Resource Usage dialog box.
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3. Double-click on the Signal Compiler block and click Compile to recompile your

design in the Quartus II software.

The Resource Usage block updates to show a summary of the estimated logic,

RAM and DSP block usage (Figure 3-23).

Figure 3-23. Resource Usage Block
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The Resource Usage dialog box updates to show a detailed report of the resources
that each of the blocks require in your model that generate hardware.

For example, Figure 3-24 shows the hardware resources that the Product block

requires in the amplitude modulation example.

Figure 3-24. Resource Usage Dialog Box
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“ @ The information depends on the selected device family. Refer to the device

documentation for more information.

You can also click the Timing tab and click Highlight path to highlight the critical
paths on your design.

"=~ When the source and destination in the dialog box are the same and a single
block is highlights, the critical path is due to the internal function or a
feedback loop. For a more complex example, the entire critical path through
your design may highlight.

Loading Additional ModelSim Commands

When you import HDL as a black box, DSP Builder creates a subdirectory
DSPBuilder<model name>_import. Any Tcl script *_add_msim.tcl in this subdirectory
automatically sources when you launch ModelSim.

You should not modify the generated scripts, but you can create you own scripts such
as <user name>_add_msim.tcl, which contain additional ModelSim commands that
you want to load into ModelSim.

Making Quartus Il Assignments to Block Entity Names

The VHDL entity names of the blocks in a DSP Builder design are dependent on the
block’s parameter values. Blocks of the same type and same parameterization share a
common VHDL entity.

The entity names have the following format:

<block type name> GN<8 alphanumeric characterss>
For example, a Delay block entity name:

alt dspbuilder delay GNLVAGVO3B

Changing the parameterization of the block causes the entity name to change. If you
want to make an assignment to a block in the Quartus II project, and for the
assignment to remain when the block parameters change, you can use regular
expressions in the assignments.
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For example, you may want to make a Preserve Registers assignment to the Delay
blocks in Figure 3-25 to prevent them from merging.

Figure 3-25. Entity Name Assignment Example
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Using the Quartus II Assignment Editor and Node Finder tools, you can identify the
names of the registers and make the assignments to them. For example, if your model
is my_model, the names may be:

my model GN:auto inst|alt dspbuilder delay GNLVAGVO3B:Delay|alt dsp
builder SDelay:Delayli|DelayLine

my model GN:auto inst|alt dspbuilder delay GNLVAGVO3B:Delayl|alt ds

pbuilder SDelay:Delayli|DelayLine
These assignments prevent merging of the registers. If you change the length of the
delay, the assignments are no longer valid. However, you can edit the To field of the
assignment and use a regular expression that is still valid if the entity name changes
due to a parameter change: Replace the eight alphanumeric characters following the
GN in the block entity name with . {8}, which is a regular expression that matches any
eight characters. The targets of the assignments then become:

my model GN:auto inst|alt dspbuilder delay GN.{8}:Delay|alt dspbuil
der SDelay:Delayli|DelayLine

my model GN:auto inst|alt dspbuilder delay GN.{8}:Delayl|alt dspbui
lder SDelay:Delayli|DelayLine

If you want the assignment to apply to the whole block, not just the specific nodes,
you can use the following code:

my model GN:auto inst|alt dspbuilder delay GN.{8}:Delay
my model GN:auto inst|alt dspbuilder delay GN.{8}:Delayl

Figure 3-26 shows this example in the Quartus II Assignment Editor.

Figure 3-26. Preserve Registers Assignment in the Quartus Il Assignment Editor

Ta Assignment Mame  |Value |Enabled
0 dk Clock Settings dlk Yes
0 preserve_regs_GM:auto_inst|alt_dspbuilder_delay_GM.{8k:Delay |Preserve Reaisters |On es
0 preserve_regs_GM:auto_inst|alt_dspbuilder_delay_GM.{8}:Delayl |Preserve Registers |On  |Yes
CENEW T | <<news = <<new s>
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This type of assignment can be useful for a complicated block that contains many
registers when you want the assignment to apply to all of the registers.
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Altera provides a number of parameterizable intellectual property (IP) MegaCore
functions that you can integrate into the Simulink model of your DSP Builder designs.

The OpenCore Plus evaluation feature allows you to download and evaluate these
MegaCore functions in hardware and simulation prior to licensing.

Blocks represent these MegaCore functions in the MegaCore Functions library of the
Altera DSP Builder Blockset in the Simulink Library Browser.
You must parameterize and generate these MegaCore functions after you add one of

these blocks to your model.

Refer to “MegaCore Function Design Example” on page 4-3 for an example of the
design flow using these MegaCore functions.

Installing MegaCore Functions

Altera DSP MegaCore functions install with the Quartus® II software.

Refer to the MegaCore function user guides for information about each MegaCore
function.

You must run the DSP Builder MegaCore function setup command after installing
new MegaCore functions to update DSP Builder.

To run this setup command, follow these steps:

1. Start the MATLAB software. If MATLAB is already running, ensure you close the
Simulink library browser.

2. Use the cd command at the MATLAB prompt to change directory to the directory
where DSP Builder is installed.

3. Run the setup command by typing the following at the MATLAB prompt:

alt dspbuilder setup megacore +
The process of building the MegaCore function blocks may take several minutes. Do
not close MATLAB before the process completes. Expect and ignore any messages of

the form “Cannot find the declaration of element 'entity'.” when installinga
new MegaCore library.

Running this command, creates a MegaCore Functions subfolder below the Altera
DSP Builder Blockset in the Simulink Library Browser.

In this folder, there is a blue block with a version name for each of the installed
MegaCore functions.
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Updating MegaCore Function Variation Blocks

=

Although a DSP Builder design using MegaCore function blocks from the MegaCore
Functions library can be translated by Signal Compiler into a VHDL or Verilog HDL
model, a MegaCore function variation block always uses an intermediate VHDL file
to record parameters.

These blocks may revert to their unconfigured appearance if the VHDL file that
describes the function variation is available but the simulation database (.simdb) file
is not.

Update a block if you change the version of the MegaCore function you are using. In
these cases, you can update the MegaCore function variation blocks in your design
using the alt_dspbuilder refresh megacore command. This command recreates the
simulation files based on the VHDL file for each MegaCore function block in the
current Simulink model.

A Quartus II license must be available on the machine for the command to execute
without errors.

Design Flow Using MegaCore Functions

Using MegaCore functions in the MATLAB or Simulink environment involves the
following steps:

1. Add the MegaCore function to the Simulink model and give the block a unique
name.

2. Parameterize the MegaCore function variation.

3. Generate the MegaCore function variation.

4. Connect your MegaCore function variation to the other blocks in your model.
5. Simulate the MegaCore function variation in your model.

Refer to the appropriate MegaCore function user guide for information about the
design flow used for each MegaCore function.

Adding the MegaCore Function in the Simulink Model

DSP Builder Handbook

Add a MegaCore function to a Simulink model by dragging a copy of the block from
the Simulink Library Browser to your design workspace like any other Simulink
block.

The default name of a MegaCore function block includes its version number. If you
add more than one copy of a block in the same model, this number is automatically
incremented to make the name unique. The correct version number still shows on the
body of the block. Altera recommends that you rename all blocks representing
MegaCore functions with a name describing their use in your design. Using unique
block names ensures that all the generated entities for the same MegaCore function in
a hierarchical design also have unique names.

After adding the block and before parameterization, save your model file.
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Parameterizing the MegaCore Function Variation
Double-click the MegaCore function block to open the IP Toolbench or MegaWizard

interface.

I'=" You can also double-click on a block to re-open and modify a previously
parameterized MegaCore function variation.

Generating the MegaCore Function Variation

Before you can connect the block to your design, generate a MegaCore function
variation after you have parameterized the MegaCore function.

Click Generate in IP Toolbench (or Finish in the MegaWizard interface) to generate
the necessary files for your MegaCore function variation.

DSP Builder also performs an additional step of optimizing your model for use in
Simulink.

Connecting the MegaCore Function Variation Block to the Design

The Simulink block now has the required input and output ports as parameterized in
IP Toolbench or the MegaWizard interface. You can connect these ports to other Altera
DSP Builder blocks in your Simulink design.

Simulating the MegaCore Function Variation in the Model
You can simulate the Simulink block representing the MegaCore function variation

like any other block from the Simulink Library Browser.

'~ Ensure that the Simulink simulation engine is set to use the discrete solver by
selecting fixed-step type under Solver Options in the Configuration Parameters
dialog box.

You should reset the MegaCore function at the start of the simulation to avoid any
functional discrepancy between RTL simulation and Simulink simulation (“Startup &
Initial Conditions” on page 3-17).

MegaCore Function Design Example

This tutorial shows how to create a custom low-pass FIR filter MegaCore function
variation using the IP Toolbench interface.

L=~ This tutorial assumes that your PC has the Altera MegaCore IP Library.

Creating a New Simulink Model
To create a new Simulink workspace, follow these steps:
1. Start the MATLAB or Simulink software.
2. On the File menu, point to New and click Model to create a new model window.

3. Click Save on the File menu in the new model window.
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4. Browse to the directory in which you want to save the file. This directory becomes
your working directory. This tutorial creates and uses the working directory <DSP
Builder install path>\DesignExamples \Tutorials\MegaCore

5. Type the file name into the File name box. This tutorial uses the name
mc_example.mdl.

6. Click Save.

Adding the FIR Compiler Function
To place a FIR Compiler MegaCore function block in your design, follow these steps:

1. On the View menu In your Simulink model window, click Library Browser. The
Simulink Library Browser displays.

2. Select the MegaCore Functions library from the Altera DSP Builder Blockset
folder in the Simulink Library Browser (Figure 4-1 on page 4-4).

Figure 4-1. MegaCore Functions Library

_E! Simulink Library Browser g@
File Edt View Help

' [ = == | |Entersearchterm [ e ﬁ

Libraries Library: Altera DSP Builder Blockset/MegaCore Functions , 4 ; ¥ .

- T Simulink [a]

EAnera DSP Builder Advanced Blockset

- @ Attera DSP Builder Blockset

- All Blocks

-~ Altlab

- Arithmetic
[+]-Boards

cic v_0

- Complex Type

- Gate & Control
[+]-Interfaces

10 & Bus

- MegaCore Functionz

- Rate Change

- Simulation Blocks Library

fir_compiler_v3_0

noo_ vB 0

reed_solomon_v3_0

- State Maching Functions
- Storage

viterbi_v3 0

HRUNN

~~\ideo and Image Processing
E'+'=--_| Communications Blocksst
E Control System Toolbox s ||

EHnt:k D&éc'ripﬁun. : X

e

fir_compiler_v9_0: When you double-click on thiz block it invokes the megacore user interface which allows the
user to generate all the files required to integrate the parameterized core into the model.

Showing: Altera DSP Builder Blockset/MegaCore Functions

DSP Builder Handbook June 2012  Altera Corporation
Volume 2: DSP Builder Standard Blockset



Chapter 4: Using MegaCore Functions 4-5
MegaCore Function Design Example

3. Drag and drop a blue versioned fir compiler v9.0 block into your model
(Figure 4-2).

Figure 4-2. FIR Compiler Block Placed in Simulink Model

fir_compiler.0

tir compiker v 0

4. Rename the block tomy fir compiler. To rename the block, click the default name
(the text outside of the block itself) and edit the text. Naming conventions are
described in “DSP Builder Naming Conventions” on page 3-1.

Parameterizing the FIR Compiler Function

To use FIR Compiler to create a MegaCore function variation that fits the specific
needs of your design, follow these steps:

1. Double-click themy fir compiler block to start IP Toolbench.
2. Click Step 1: Parameterize to specify how the FIR filter should operate.
The Parameterize - FIR Compiler MegaCore function dialog box displays.

3. Use the default values, specifying a low-pass filter. Click Finish.

Generating the FIR Compiler Function Variation

After you parameterize the MegaCore function, to generate the files for inclusion in
the Simulink model and simulation, follow these steps:

1. Click Step 2: Generate in IP Toolbench.
2. The generation report lists the design files that IP Toolbench creates.
3. Click Exit.

“ e For more information about the FIR Compiler including a complete description of the
generated files, refer to the FIR Compiler User Guide.
Themy fir compiler block in the Simulink model updates to show the input and
output ports for your configuration (Figure 4-3). The FIR filter is ready for you to
connect it to the rest of your Simulink design.
Figure 4-3. FIR Compiler Block in Simulink Model After Generation
esat_n ast_soume_data(17:0)
asl_sink_data(7:0) ast_sink_mady
ast_sink_wvalid fir_compiler 9.0 ;
asl_soume_mady L€ bt
ast_sink_emonl:0) ast_soume_emor1:0)
my_fir_compiker
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Adding Stimulus and Scope Blocks

To create a sample design to test the low-pass filter by feeding the filter two sine
waves (Figure 4-4 on page 4-8), follow these steps:

DSP Builder Handbook

1. Add two Sine Wave blocks (from the Simulink Sources library).
& DSP Builder automatically gives the second block a unique name.
2. Use the Block Parameters dialog box to set the parameters for the Sine Wave block

(Table 4-1).

Table 4-1. Parameters for the Sine Wave Blocks

Value

Parameter ) .
Sine Wave Sine Wavel

Sine type Sample based Sample based
Time Use simulation time Use simulation time
Amplitude 64 64
Bias 0 0
Samples per period 200 7
Number of offset examples 0 0
Sample time 1 1
Interpret vector parameters as 1-D On On

3. Repeat Step 2 for the Sine Wavel block.

4. Connect the outputs from the Sine Wave and Sine Wavel blocks to an Add block
(from the Simulink Math Operations library).

5. Add an Input block (from the IO & Bus library in the Altera DSP Builder

Blockset) and connect it between the Add block and the ast _sink data pin on the
my fir compiler block.

6. Use the Block Parameters dialog box to set the parameters (Table 4-2).

Table 4-2. Parameters for the Input Block

Parameter Value

Bus Type Signed Integer
[number of bits].[] 8

Specify Clock Off

7. Add a Constant block (from the IO & Bus library) and connect this block to both

the ast_sink_valid and ast_source_ready pins on themy fir compiler block.

Add another Constant block (from the IO & Bus library) and connect this block to
the ast_sink_error pin on themy fir compiler block.
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9. Use the Block Parameters dialog box to set the parameters for the Constant block

(Table 4-3).
Table 4-3. Parameters for the Constant Blocks

Value

Parameter
Constant Constantl

Constant Value 1 0
Bus Type Single Bit Signed Integer
[Number of Bits].[] - 2
Rounding Mode Truncate Truncate
Saturation Mode Wrap Wrap
Specify Clock Off Off

10. Repeat Step 9 for the Constant1 block.

11. Add a single Pulse block (from the Gate & Control library in the Altera DSP
Builder Blockset) and connect it to the reset_n pinonthemy fir compiler

block.

12. Use the Block Parameters dialog box to set the parameters (Table 4—4).

Table 4-4. Parameters for the Single Pulse Block

Parameter Value
Signal Generation Type Step Up
Delay 50
Specify Clock Off

13. Add an output block (from the IO & Bus library in the Altera DSP Builder
Blockset) to your design and connect it to the ast_source_data pin on the

my fir compiler block.

14. Use the Block Parameters dialog box to set the parameters (Table 4-5 on

page 4-7).

Table 4-5. Parameters for the Output Block

Parameter

Value

Bus Type

Signed Integer

[number of bits].[]

18

External Type

Inferred

15. Add a Scope block (from the Simulink Sinks library). Use the ‘Scope’ Parameters
dialog box to configure the Scope block as a 2-input scope.
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16. Connect the Scope block to the Input and Output blocks to monitor the source
noise data and the filtered output.

Figure 4-4 shows how your model looks.

Figure 4-4. Connecting Blocks to the Low-Pass Filter

Single Puks
i L]
++
5 '.,.'-4'- |_>+ P 2zl _n aslt_soume_dalai17:0) —P{: o17:0 I—b—
ine Wane = ) i i
+ —-"I ir:0 P ast_sink _datai7:0) ast_sink_mardy Cutpul -
F+ Al Input T:ail sink_wvalid  fir compiler2.0 _
SEER L ast_soume_ mady ast_soume_valid
i,
Sine Wave 1 | 1 ast_sink_emn1:0) asl_soume_enmol:0)

Constant mry_tir_compiken

Constant]

Simulating the Design in Simulink

To simulate your design, follow these steps:

1. On the Simulation menu in your model, click Configuration Parameters to
display the Configuration Parameters dialog box (Figure 4-5 on page 4-8).

Figure 4-5. Configuration Parameters: mc_example/Configuration Dialog Box

43 Configuration Parameters: untitled/Configuration (Active)

[ select: | -~ Simulation time
| i-Solver |
Start time: 0.0 Stop time: | 5000
~Data Import/Export oz i
-+ DpEmization Solver options
[=]-Diagnostics
-5ample Time Type: |Fixed-step | % | Solver: discrete (no continuous states) £
-Data Validity ;
Type Conversion Fixed-step size (fundamental sample time):  auto
-Connectivity i ; :
-Compatibility Tasking and sample time options
“Model Referencing Periodic sample time constraint: Unconstrained | e
Saving ; e : |
Hardware Implementation Tasking mode for periodic sample times: Auto |2
-Model Referencing [] automatically handle rate transition for data transfer

i

eal-Time Workshop
i-Repart
-Comments
-Symbols
-Custom Code

- Debug

i Interface

[] Higher priority value indicates higher task priority

J oK J [ Cancel ] [ Help Apply
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2. Select the Solver page and set the parameters (Table 4-6).

Table 4-6. Configuration Parameters for the singen Model

Parameter Value

Start time 0.0

Stop time 5000

Type Fixed-step

Solver discrete (no continuous states)
a®

= For detailed information about solver options, refer to the description of the
Solver Pane in the Simulink Help.

3. Click OK.

4. On the Simulation menu in the simulink model, click Start. The scope output
shows the effect of the low-pass filter in the bottom window (Figure 4-6).

Figure 4-6. Simulation Output
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Check that the FIR filter block behaves as you expect and filters high-frequency
data as a low-pass filter.

'~ You may need to use the Autoscale command in the Scope display to view
the complete waveforms.

Compiling the Design

To create and compile a Quartus II project for your DSP Builder design, and to
program your design onto an Altera FPGA, add a Signal Compiler block. Follow
these steps:

1. Select the AltLab library from the Altera DSP Builder Blockset folder in the
Simulink Library Browser.

2. Dragand drop a Signal Compiler block into your model.
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3. Double-click the new Signal Compiler block in your model. The Signal Compiler
dialog box appears (Figure 4-7).

Figure 4-7. Signal Gompiler Dialog Box

< DSPBuilder - Signal Compiler

Description

This block contrals the compilation of the design,

Parameters

Quarkus II Projeck: mc_example_dspbuildermc_example.qpf

Stratix 11 vl

Farmily: ! [] Use Board Black to Specify Device

Device:  alUTO

Simple | Advanced | SignalTap 1| Export |
Step 1 - Compile Design

Step 2 - Seleck Device to Program

Scan Jtag I V

Skep 3 - Program Device |

s

Messages

Warning: Ignored assignments for entity "tsadd_reg_top_cen” -- entity does nat exist in ]
design E
“Warning: Assignment of entity set_global_assignment -name
AUTO_SHIFT_REGISTER _RECOGMITION OFF -entity tsadd_reg_top_cen is ignored
Info: Writing out detailed assembly data For power analysis
Info: Assembler is generating device pragrarmming Files
Infos Quartus 11 Assembler was successful, 0 errors, 32 warnings
Info: Allocated 179 megabytes of memory during processing
Info: Processing ended; Wed Sep 05 09:45:50 2007 =
Info: Elapsed kime: 00:00:12 B

(04 Cancel

4. Click Compile.
5. When the compilation has completed successfully, click OK.

Performing RTL Simulation

To perform RTL simulation with the ModelSim software, add a TestBench block.
Follow these steps:

1. Select the AltLab library from the Altera DSP Builder BlockSet folder in the
Simulink Library Browser.

2. Drag and drop a TestBench block into your model.
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3. Double-click on the new TestBench block. The TestBench Generator dialog box
appears (Figure 4-8).

Figure 4-8. TestBench Generator Dialog Box

.ﬂ!; DSPBuilder - Testbench Generator - mc_example E]@ﬁ

Description

This block controls automatic generation of the kest bench, Enabling testbench generation may
slow simulation as all input and output values are stored to file,

Parameters

Enable Test Bench generation.

Simple | Advanced | Configuration

Zompare againsk HOL Compare Simulink simulation against ModelSim

Messages

4. Ensure that Enable Test Bench generation is on.
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5. Click the Advanced Tab (Figure 4-9).

Figure 4-9. TestBench Generator Dialog Box Advanced Tab

.{!3 DSPBuilder - Testbench Generator - mc_example E]@

Description

This block controls automatic generation of the kest bench, Enabling testbench generation may
slow simulation as all input and output values are stored to file,

Parameters

Enable Test Bench generation.
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warning: Ignored assignments For entity "tsadd_reg_top_cen” -- entity does not exist in
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Warning: Assignment of entity set_global_assignment. -name
ATO_SHIFT_REGISTER_RECOGMITION OFF -entity ksadd_reg_top_cen is ignored
Info; Quartus I Analysis & Elaboration was successful, O errors, 34 warnings

Info: Allocated 843 megabytes of memory during processing

Info; Processing ended: Wed Sep 05 09:51:59 2007

Info; Elapsed time: 00:00:20
Info: Creating ModelSim kestbench script,

Info: @enerating simulation models, (=2
el

| ]

6. Turn on the Launch GUI option to launch the ModelSim GUI if you invoke
ModelSim simulation.

7. Click Generate HDL to generate a VDHL-based testbench from your model.
8. Click Run Simulink to generate Simulink simulation results for the testbench.
9. Click Run ModelSim to simulate your design in ModelSim.

Your design loads into ModelSim and simulates with the Wave window

displaying the output.

"=~ All waveforms initially show using digital format in the ModelSim Wave
window.

10. Right-click the input signal in the ModelSim Wave window and click Properties in
the pop-up menu to display the Wave Properties dialog box. Click the Format tab
and change the format to Analog with height 75 and Scale 0.25.

11. Repeat Step 10 for the output signal in the ModelSim Wave window and use the
Wave Properties dialog box to change the format to Analog with height 75 and
scale 0.001.
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12. Click Zoom Full on the right button right button pop-up menu in the ModelSim
Wave window.

The ModelSim simulator now displays the input and output waveforms in analog
format (Figure 4-10).

Figure 4-10. Generated HDL for mc_example Simulated in ModelSim Simulator
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Note to Figure 4-10:

(1) This waveform display format shows the input and output signals as analog waveforms.

1. Click Compare Results in the Testbench Generator dialog box to compare the
simulink results with the ModelSim-generated results. The message Exact Match
indicates that the results are identical.

2. Click OK to close the Testbench Generator dialog box.

MegaCore Functions Design Issues

This section describes some of the design issues to consider when using MegaCore
functions in a DSP Builder design.

Simulink Files Associated with a MegaCore Function

DSP Builder stores the files that support the configuration and simulation of a
MegaCore function variation in a subdirectory of the directory containing your
Simulink MDL file DSPBuilder_<design name>_import. When copying a design from
one location to another, make sure that you also copy this subdirectory.
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DSP Builder needs the following specific files to simulate a MegaCore function
variation:

m If your MegaCore function variation is my_function, and generates in VHDL, your
design variation is in a my_function.vhd file in your design directory.

m If your design is my_design, the simulation information is in a
DSPBuilder_my_design_import/my_function.vo.simdb file.

Simulating MegaCore Functions That Have a Reset Port

MegaCores functions that have a reset port must have a reset cycle at the start of
Simulink simulation to produce correct simulation results. The length of this reset
cycle must be of sufficient length, and depends on the particular MegaCore function
and parameterization.

For example, in Figure 4-11, DSP Builder cannot tie the reset to a constant because the
simulation does not match hardware.

Figure 4-11. MegaCore Function Design With a Reset Port
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You must simulate an initial reset cycle (with the step input) to replicate hardware
behavior. As in hardware, this reset cycle must be sufficiently long to propagate
through the core, which may be 50 clock cycles or more for some MegaCore functions
such as the FIR Compiler.

Additional adjustment of the reset cycles may be necessary when a MegaCore
function receives data from other MegaCore functions, to ensure that the blocks leave
the reset state in the correct order and DSP Builder delays them by the appropriate
number of cycles.

Setting the Device Family for MegaCore Functions

DSP Builder Handbook
Volume 2: DSP Builder Standard Blockset

Most of the MegaCore functions available in DSP Builder use the IP Toolbench
interface.

June 2012  Altera Corporation



Chapter 4: Using MegaCore Functions 4-15
MegaCore Functions Design Issues

The CIC MegaCore function uses a MegaWizard user interface. This interface always
inherits the device family setting from the Signal Compiler block. If there is no
Signal Compiler block in your design, DSP Builder uses the Stratix device family by
default.

MegaCore functions that use IP Toolbench allow you to modify the device family
setting in the IP Toolbench interface.

[l=" The FFT, FIR Compiler, NCO, Reed Solomon Compiler, and Viterbi Compiler
MegaCore functions use IP Toolbench.

If you change the device family in Signal Compiler, you must check that any IP
Toolbench MegaCore functions have the correct device family set to ensure that the
simulation models and generated hardware are consistent.
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Adding the HIL block to your Simulink model allows you to cosimulate a Quartus II
software design with a physical FPGA board implementing a portion of that design.
You define the contents and function of the FPGA by creating and compiling a
Quartus II project. A simple JTAG interface between Simulink and the FPGA board
links the two.

The main benefits of using the HIL block are faster simulation and richer
instrumentation. The Quartus II project you embed in an FPGA runs faster than a
software-only simulation. To further increase simulation speed, the HIL block offers
frame and burst modes of data transfer that are significantly faster than single-step
mode when you use it with suitable designs.

The HIL block also makes available to the hardware a large Simulink library of sinks
and sources, such as channel models and spectrum analyzers, which can give you
greater control and observability.

This chapter explains the HIL block design flow, walks through an example using the
HIL block, and discusses the optional burst and frame data transfer modes.

HIL Design Flow

The HIL block in AltLab library of the Altera DSP Builder Blockset enables the HIL
functionality. It represents the functions implemented on your FPGA, and works
smoothly with the normal DSP Builder/Simulink work flow.

The HIL design flow comprises the following steps:

1. Create a Quartus II project that defines the functions you want to co-simulate in
hardware and use Signal Compiler block to compile the Quartus II project
through the Quartus II Fitter.

2. Add the HIL block to your Simulink model and import the compiled Quartus II
project into the HIL block. You can also connect instrumentation to your HIL block
by adding additional blocks from the Simulink Sinks and Sources libraries.

"= If the original design contains a Clock block that defines a period and
sample time that is different from the default values, you must add a Clock
block with the same values as the HIL block.

3. Specify parameters for the HIL block, including the following options:

m  The Quartus II project to define its functionality

m  The clock and reset pins

m The reset active level

m The input and output pin characteristics

m  The use of single-step versus burst mode

4. Compile the HIL block to create a programming object file (.pof) for hardware
cosimulation.
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5. Scan for JTAG cables and hardware devices connected to the local host or any
remotely enabled hosts.

6. Program the board that contains your target FPGA.

7. Simulate the combined software and hardware system in Simulink.

I'=" When using a HIL block in a Simulink model, set a fixed-step, single tasking
solver.

Figure 5-1 shows this system-level design flow using DSP Builder.

Figure 5-1. System-Level Design Flow
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HIL Requirements

The HIL block has the following requirements:

m An FPGA board with a JTAG interface (Stratix, Stratix II, Stratix III, Cyclone,
Cyclone II, or Cyclone III device).

m A valid Quartus II project that contains a single clock domain from Simulink. DSP
Builder creates an internal Quartus II project when you run Signal Compiler.

m A JTAG download cable (for example, a ByteBlasterMV™, ByteBlaster™ II,
ByteBlaster, MasterBlaster™, or USB-Blaster™ cable).

B A maximum of one HIL block for each JTAG download cable.

HIL Design Example

DSP Builder includes the following design examples in the <DSP Builder install
path>\DesignExamples\Tutorials\HIL directory that demonstrate the use and
effectiveness of HIL:

m Imaging edge detection

DSP Builder Handbook June 2012  Altera Corporation
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m Export example

m Fast Fourier Transform (FFT)

m Frequency sweep

This section shows the frequency sweep design.

This tutorial uses the Stratix Il hardware device on an Altera Stratix II EP2560 DSP
Development Board. However, you can also use any other supported device and

development board.

To create a frequency sweep design, follow these steps:

1. Run MATLAB, and open the model FreqSweep.mdl in the <DSP Builder install
path>\DesignExamples\Tutorials\HIL\FreqSweep directory. Figure 5-2 shows
the model.

Figure 5-2. Frequency Sweep Model
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2. Double-click the Signal Compiler block. In the dialog box that appears
(Figure 5-3 on page 5-4), click Compile.

This action creates a Quartus II project, FreqSweep.qpf, compiles your model for
synthesis, and runs the Quartus II Fitter.

Progress is indicated by status messages and a scrolling bar at the bottom of the
dialog box.

Figure 5-3. Signal Compiler Dialog Box, Simple Tab
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30

3. Review the Messages, then click OK to close the Signal Compiler dialog box.
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4.

Replace the internal functions of the frequency sweep model with an HIL block.
Open the model FreqSweep_HIL.mdl from the FreqSweep directory (step 1).

Figure 5-4 shows this model, with the HIL block in place.

Figure 5-4. Frequency Sweep Design Model Using the HIL Block
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5. Double-click the frequency sweep HIL block to display the Hardware in the loop
dialog box.
6. Select the Quartus II project by browsing into the FreqSweep_dspbuilder
directory to locate the FreqSweep.qpf file.
L= The full path to this file is visible in the dialog box when you select this file.
7. Select Clock from the list of available clock pins.

"=~ HIL does not support multiple clock domains and only the specified signal
is the HIL clock signal. The HIL treats any other clocks in your design as
input signals.

8. Select aclr from the list of available reset pins.

9. Identify the signed ports:
m  Select the Input port and click Unsigned.
m  Select each output port (OutputCordic and OutputFilter) and click Signed.

10. Select the reset level to be Active_High.

11. Select the mode of operation by turning off Burst Mode.

12. Click Next page. to display the second page of the Hardware in the loop dialog
box.

13. Specify a value for the FPGA device and click Compile with Quartus II to
compile the HIL design.

[l If no output writes to the MATLAB command window, check that the
original Quartus II project is up-to-date and compiles with he same version
of the Quartus II software that compiles your Simulink model.

14. Click Scan Jtag to find available cables and hardware devices in the chain.
15. Select the JTAG download cable that references the required FPGA device and

June 2012  Altera Corporation

click Configure FPGA to program the FPGA on the board.
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16. Click Close.

17. Simulate your design in Simulink. Figure 5-5 shows the scope display from the
finished design.

Figure 5-5. Scope Output from the FrequencySweep Model with HIL Block
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Burst Mode

The Quartus II software infrastructure that communicates with the FPGA through
JTAG—system-level debugging (SLD)—uses a serial data transfer protocol.

To maximize the throughput of this data transfer, the HIL block offers a burst mode
that buffers the stimulus data and presents it in bursts to the hardware.

Table 5-1 shows the advantages and disadvantages of using burst mode compared
with the normal single-step mode.

Table 5-1. Comparing Single-Step and Burst Modes

Mode Advantages Disadvantages
Cycle accurate simulation.
Single step Feedback is possible outside of | High SLD overhead.
the HIL block.
m Low SLD overhead. Alatency is introduced on the output signals of
Burst w Fast HIL results. the HIL block making. feedback loop difficult
outside the FPGA device.
Using Burst Mode
To activate burst mode turn on the Burst Mode option in the Hardware in the loop
dialog box.
DSP Builder Handbook June 2012  Altera Corporation

Volume 2: DSP Builder Standard Blockset



Chapter 5: Using HIL

5-7

Troubleshooting HIL Designs

When you set this option, you can specify the required number of data packets as the
Burst length. The HIL block sends data to the hardware in bursts of the size you
specify.

DSP Builder determines the size of the packet by the larger of the total input data
width or the total output data width. If the packet size multiplied by the Burst length
exceeds the preset data array, DSP Builder sets the Burst length to 1.

Simulation using burst mode works the same as single clock mode, but DSP Builder
introduces a latency of the specific packet size on the output signals of the HIL blocks.
As a consequence, feedback-loops may not work properly unless you enclose them in
the HIL block, and some intervention may be necessary when comparing or
visualizing HIL simulation results.

The HIL block uses software buffers to send and receive from the hardware, so you
can change these buffer sizes without recompiling the HIL function.

Troubleshooting HIL Designs

=

This section describes various issues that you may encounter when you are using HIL
designs.

If the top-level of your design changes, compile and reload the Quartus II project into
HIL to ensure that all information is up-to-date.

Fails to Load the Specified Quartus Il Project

HIL reads design information, such as clock, reset, and input and output ports, from
the specified Quartus II project. However, it can fail to load your project if the project
is not compiled with the Quartus II Fitter, there is a Quartus II version mismatch, or
the Quartus II project file is not up-to-date.

No Inputs Found From the Quartus Il Project

This issue occurs if the DSP Builder model file contains only the internally induced
signals, such as from a counter, and also does not produce any outputs. However, HIL
simulation works correctly.

No Outputs Found From the Quartus Il Project

This issue occurs if your design does not have any outputs and makes the HIL
simulation meaningless.

HIL Design Stays in Reset During Simulation

An asynchronous reset is permanently asserted for a HIL design.

Action:

Check that the reset active level matches the setting in the original design. Recom